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● Be sure to read this Instruction Manual thoroughly 

before operating the product. 

● In particular, make sure to carefully read and 

understand all descriptions related to safety. 
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convenient place where it can be quickly taken 

out and read whenever necessary. 
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Chapter 1 Introduction 

 Personal computer software KCA–SF–98D is designed to support you in creating programs for 

ROIBOT when you use a personal computer as the host computer. 

Before creating a program, you are requested to read through and completely understand this 

manual. 

 

■ 1.1 Safety 

 To use our arm robot ROIBOT series safely, the items you have to strictly observe are contained in the 

appropriate robot instruction manual and the safety booklet attached to the robot.  Be sure to 

completely read them. 

This software controls axis motions by teaching and program execution.  To assure safety, equip an 

emergency stop pushbutton switch near the operator before starting such operations. 

 

■ 1.2 Features 

 • This software can be used on the personal computer where the English versions of Microsoft 

Windows 7/8/10 run. 

 • A program can be edited easily by using the multi-window screen editor. 

 • Data such as program and table can be sent to and received from the robot controller.  It is also 

possible to save the data as a file. 

 • Axis motions can be controlled by teaching and program execution. 

 • At program printing (i.e., output to the printer), a title and comment can be added, which is very 

convenient to debug and verify the program. 
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■ 1.3 About Instruction Manual 

 

■ 1.3.1 Descriptions on Operations 

 For the basic Windows operations and terms, refer to the Windows manual and help. 

In this manual, the hard disk drive unit of the personal computer is assigned to "C" and the CD–

ROM drive unit to "D". 

Additionally, the robot controller is explained based on KBB series controller KCA–20–M00. 

 

■ 1.3.2 Structure of Instruction Manual 

 1. Introduction 

  This section deals with introduction of applicable devices and software installing procedures. 

 2. Basic operations 

This section deals with the basic operations covering from the start to end of the software. 

 3. File editing 

This section deals with the procedures for using the KCA–SF–98D, including the basic ones. 

 4. Menu bar 

This section deals with each command on the menu bar. 

 5. Others 

This section deals with the descriptions and remedies of errors. 

 

■ 1.3.3 Notation in the Manual 

 [XXX] : Signifies the button named "XXX" or the menu named "XXX". 

 "XXX" : Represents the display of "XXX". 

 Sequential program, palletizing program and so on are generically called the "program". 

Point table, MVM table and so on are generally called the "table". 

Program and table are generically called the "data". 

KCA-25-M10/M40/M80, KCA-20-M00/M01, KCA-10-M00/M01 and KCA-10-M00B/01B are 

generically called the "enhanced master unit". 

KCA-20-M10/M40 and KCA-10- M10/M40 are generically called the "master unit". 

But the axis numbers of KCA-25-M10/M40/M80 are A0 to A3 as well as "master unit". 
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■ 1.3.4 Corporate Name 

 Microsoft Windows, Microsoft Windows NT and Windows logo mark are the registered trademarks 

or trademarks. 

 

■ 1.4 System Structure 

 The minimum hardware required for installing and operating the KCA–SF–98D is as follows: 

 • Personal computer 

The personal computer where the English versions of Microsoft Windows 7/8/10 run. 

  The following are required for the hardware environment. 

  CD–ROM drive unit 

  Serial port 

  Hard disk free area: 20 MB or more 

  Memory free area: 100 MB or more 

 • Printer 

Printer that can be connected with your personal computer and allows printing from the Windows. 

 • Communication cable 

Connects the controller and computer. Use the KCA–PCBL–31. 

 • Display 

Resolution 800  600 pixel or more 
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■ 1.5 Connecting with Robot Controller 

 Connect the personal computer where the KCA–SF–98D software is already installed with the robot 

controller, etc., in the manner below. 

 • Applicable controller 

   KCA–25–M10/M40/M80, 

   KCA–20–M00/M01, 

   KCA–10–M00/M01, KCA–10–M00B/M01B, 

   KCA-20–M10/M40, KCA-10–M10/M40, 

   KCA–01–M05 

 • Connection with robot controller 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Connect the controller side of the communication cable with the teach pendant connector, and the 

personal computer side of the same cable with the RS232C terminal. 

 

 

Axis (actuator) 

Robot controller 

Personal computer Printer 

Communication cable 

Emergency stop pushbutton switch 
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■ 1.6 Installing 

 Before using the KCA–SF–98D software, you have to install it on your personal computer first.  

Install the software according to the procedures given below. 

Before installing, terminate all application programs which are in operation. 

The following explanations are made with the hard disk drive unit of the personal computer assigned 

to "C". 

 

1. Insert the install disk into the CD–ROM drive unit. 

 

 2. Execute “KCA–SF–98D.msi” in the install disk as an administrator. 

  

 3. The “KCA–SF–98D” setup screen 

opens.  Click the [Next] according to 

the instructions on the screen. 
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 4. Next, the “License Agreement” screen 

is called. 

Read through and completely 

understand the Agreement first.  Then 

click the “I Agree” option button. 

Click the [Next] button. 

 

  

 5. Specify the folder where you wish to 

install the KCA–SF–98D. 

Normally, a folder named "KCA–SF–

98D" is automatically created in the 

[C:¥Program Files (x86)¥CKD] folder to 

install the software. 

Make sure of the folder name where the 

KCA–SF–98D is to be installed, then 

click the [Next] button. 

 

  

 5.1 When you wish to specify the new 

folder on the “[Select Installation 

Folder” screen, click the [Browse] 

button. 

When the “Browse for Folder” 

screen is displayed, select the drive 

and folder where you wish to install 

the software, and click the [OK] 

button. 
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 5.2 When you click the [Disk Cost] 

button on the “Select Installation 

Folder” screen, the “KCA–SF–98D 

Disk Space” screen appears, where 

the disk space, available space and 

disk size required for installing the 

KCA–SF–98D of each drive are 

displayed. 

 

 

  

 6. When you click the [Next] button on the 

“Select Installation Folder” screen, the 

“Confirm Install” screen is displayed. 

To start installing the software, click the 

[Next] button, and the installation starts. 

 

  

 7. While the software is installed, the 

screen as shown right is displayed.  

Wait until the installation completes. 
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 8. When the software has been installed, 

the screen as shown right is displayed. 

Now, the installation has finished.  

Click the [Close] button to quit the setup 

screen. 
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Chapter 2 Basic Operations 

 

■ 2.1 How to Start 

 First, let's start the KCA–SF–98D. 

 

 1. Click the [Start] button on the Windows 

task bar. 

 2. The [Start] menu is displayed. 

 3. Set the mouse pointer to [Programs]. 

 4. Click the [KCA–SF–98D] file folder. 

 5. Click [KCA–SF–98D]. 

 

 

 6. When the menu screen is displayed, 

startup of the KCA–SF–98D has 

finished. 

 * The KCA–SF–98D can be started also 

by double-clicking the [KCA–SF–98D] 

icon shown on the desktop. 

  [KCA–SF–98D] icon →  

 

KCA-SF-98D 

KCA-SF-98D 
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■ 2.2 Setting Type of Robot Controller 

 When the KCA–SF–98D has been installed newly, or when the robot controller has been replaced, 

specify the type of the robot controller first. 

 

 1. Click [Option (O)] on the menu bar. 

 2. Select and click [System Environment 

Setting (E)] from the command list. 

 

 

 3. The [SYSTEM ENVIRONMENT 

SETTING] screen appears. 

 * For the column of “ALL-CLEAR 

SEQUENTIAL BEFORE TRANSMIT”, 

see Para. 4.6.2. 

 

 

 4. Click [▼] of the “CONTROLLER 

TYPE” setting box. 

 

 5. Select the connected controller from 

the dropdown menu, then click it. 
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 6. Click [SETTING] of the “SYSTEM 

ENVIRONMENT SETTING” screen. 

 

 

 7. The”[COMMUNICATION CONDITION” 

screen appears. 

 8. DO NOT change the following four (4) 

items. 

  DATA LENGTH: 8 

STOP BIT: 1 

PARITY: EVEN (E) 

FLOW CONTROL: NONE 

 9. Select the communication port, 

referring to the instruction manual of 

your personal computer and Windows 

instruction manual. 

 

 10. Click [OK] and return to the “SYSTEM ENVIRONMENT SETTING” screen. 

 11. Click the [OK] button on the “SYSTEM ENVIRONMENT SETTING” screen. 
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■ 2.3 Data Transfer and Saving from Robot Controller to PC 

 A sequential program in the robot controller can be transferred to the personal computer (KCA–SF–

98D) and saved as a file. 

Before starting this operation, connect the personal computer with the robot controller.  

 

 1. Click [Operation (C)] on the menu bar. 

 2. Select and click [Receive from 

Controller (U)] from the command list. 

 

 

 3. The “RECEIVE (HOST COMPUTER <- 

CONTROLLER)” screen appears. 

 4. Click [▼] of the “Text Data” box. 

 * “Text Data” box 

→  

 5. The dropdown menu opens. 

 

  



2-5 

 6. Click [SEQUENTIAL PROGRAM] from 

the dropdown menu. 

 7. Click [OK] on the “RECEIVE (HOST 

COMPUTER <- CONTROLLER)” 

screen. 

 

 

 8. The “Select file” screen appears. 

 9. Make sure that the KCA–SF–98D 

folder is shown in the “Save in (I)” box. 

 

 10. Specify the file name under “File name (N)”.  Here, enter "test" temporarily. 

 11. DO NOT change the type of the file set under “Save as type”. 

 12. Click the [Save] button. 

 

 13. The “SPECIFY RECEIVED RANGE” 

screen is called on the display. 

 14. Select the task number you wish to 

receive from the “Task No.” box.  

Here, select "01" temporarily. 

 15. Specify the range of the steps you wish 

to receive under “Step No.”.  Here, 

enter "0001 – 0100" temporarily. 

 16. Click the [OK] button. 

 

  

KCA-SF-98D 
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 17. The “receiving” confirmation screen is 

displayed. 

 18. Click the [OK] button. 

 

 

 19. The message saying "Receiving 

SEQUENTIAL PROGRAM!" is 

displayed under the lower side of the 

“RECEIVE (HOST COMPUTER <- 

CONTROLLER)” screen, and receiving 

of the file starts. 

Wait until the file has reached. 

 

 

 20. The “Receiving” finish screen is 

displayed. 

 21. Click the [OK] button. 

 22. Click the [END] button on the 

“RECEIVE (HOST COMPUTER <- 

CONTROLLER)” screen to exit from 

the same screen. 

 Now, receiving and saving of the sequential 

program complete. 
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■ 2.4 Data Display and Editing 

 Let's display the sequential program saved in Para. 2.3 above on the editing screen. 

 

 1. Click [File (F)] on the menu bar. 

 2. Select and click [Open (O)] from the 

command list. 

 

 

 3. The [FILE OPEN] screen is displayed. 

 4. Select [SEQUENTIAL]. 

 5. Click the [OK] button. 

 

 

 6. The [Select file] screen appears. 

 7. Select the sequential program file as 

saved before. 

 8. Click the [Open (O)] button. 

 

  

KCA-SF-98D 
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 9. The [SEQUENTIAL EDITING] screen 

opens to display the program. 

 * This program can be added, changed 

and deleted at your discretion.  For 

the editing operation, see Para. 3.2. 

 10. After display and editing of the 

program, click [File] – [Close] from the 

menu bar to close the editing screen. 
 

 * When the contents of the file have been changed on the “SEQUENTIAL EDITING” screen, the 

“FILE SAVE CONFIRMATION”, “SYNTAX CHECK CONFIRMATION” and “TASK No. 

CONFIRMATION” screens are displayed. 

 

 11. To save the contents you have 

changed, click [Yes].  Otherwise, click 

[No]. 

When you click [Cancel], the 

[SEQUENTIAL EDITING] screen is 

called again. 

 * Unless the changed contents are 

saved, proceed to Para. 2.5 

 

 

 12. To perform program check, click [Yes].  

Otherwise, click [No.]. 

 * Unless the program check is 

performed, proceed to Step 16 of this 

paragraph. 
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 13. If an error has been found during 

program check, click [No] to correct the 

program. 

 * Unless a program error is found, or 

when [Yes] is selected on the right 

screen, proceed to Step 16 of this 

paragraph.  

 

 14. Correct the program, referring to the 

[ERROR] screen. 

 15. After the program has been corrected, 

click the [X] button on the upper right 

side of the [ERROR] screen to close it.  

Then repeat the above steps, starting 

from Step 10. 

 

 

 16. The [TASK No. CONFIRMATION] 

screen is displayed. 

When you click [Yes], the file is saved 

and the [SEQUENTIAL EDITING] 

screen closes. 

When you click [No], the file is not 

saved and the [SEQUENTIAL 

EDITING] screen closes. 

When you click [Cancel], the file is not 

saved and the system returns to the 

[SEQUENTIAL EDITING] screen. 
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■ 2.5 File Transmission 

 Let's transmit the sequential program as displayed and edited in Para. 2.4 to the robot controller. 

When the edited sequential program is transmitted, the same program range as that in the controller 

is deleted, then overwritten.  Therefore, receive and save it in another file on the controller side as 

necessary. 

When you wish to clear all sequential programs before transmission, click [DELETE] under 

“ALL-CLEAR SEQUENTIAL BEFORE TRANSMIT” of the [SYSTEM ENVIRONMENT SETTING] 

screen in Para. 2.2. 

Before transmitting the program to the controller, it is recommended to make sure by the program 

check (Para. 4.4.2.) that no error is included in the program. 

If data that does not conform to the communication format is sent, a parameter error will occur. 

Before starting this operation, connect the personal computer with the robot controller.  

 

 1. Click [Operation (C)] on the menu bar. 

 2. Select and click [Send to Controller 

(D)] from the command list. 
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 3. The [TRANSMIT (HOST COMPUTER 

-> CONTROLLER)] screen appears. 

 4. Click [▼] of the [Text Data] box. 

 5. Click [SEQUENTIAL PROGRAM] from 

the dropdown menu. 

 6. Click the [OK] button on the 

[TRANSMIT (HOST COMPUTER -> 

CONTROLLER)] screen. 

 

 

 7. The [Select file] screen appears. 

 8. Select the sequential program file as 

saved before. 

 9. Click the [Open (O)] button. 

 

  

KCA-SF-98D 
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 10. The [SPECIFY TRANSMIT RANGE] 

screen is displayed. 

 11. Select the task number you wish to 

send from the [Task No.] box.  Here, 

select "01". 

 12. Specify the range of the steps you wish 

to send under [Step No.].  Here, enter 

"0001 – 0100". 

 13. Click the [OK] button. 

When you click [Cancel], the system 

returns to the [TRANSMIT (HOST 

COMPUTER -> CONTROLLER)] 

screen in Step 3 above. 

 

 

 14. The transmitting confirmation screen is 

displayed. 

When you wish to send the file, click 

the [OK] button. 

When you wish to stop sending the file, 

click the [Cancel] button. 
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 15. The [TRANSMIT (HOST COMPUTER 

-> CONTROLLER)] screen is called on 

the display. 

 * When you click the [END] button 

during transmission, the transmission 

is interrupted (or canceled) and the 

data up to the interrupted point is sent 

to the controller. 

 

 

 16. When the transmission has finished, 

the transmitting confirmation screen 

appears.  Click the [OK] button then. 

 

 17. To exit from the [TRANSMIT (HOST COMPUTER -> CONTROLLER)] screen, click the [END] 

button. 
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■ 2.6 Printing Program 

 Let's print the program saved as the file in Para. 2.4.  

 

 1. Click [File (F)] on the menu bar. 

 2. Select and click [Print (P)] from the 

command list. 

 

 

 3. The [PRINTING] screen appears. 

 4. To print the sequential program as 

saved in Para. 2.4 above, click 

[SEQUENTIAL] under the column of 

[Individual]. 
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 5. The [Select file] screen appears. 

 6. Select the file as saved in Para. 2.4, 

then click the [OK] button. 

 

 

 7. The check box under the column of 

[File Name] is checked with 

"PRINTING" displayed. 

 * When you click the [Printer Setting] 

button, the [PRINTER SETTING] 

screen is called, where you can select 

the printer, paper size, etc. 

The printer installed beforehand in the 

Windows can be used. 

For the printer installing method and 

individual setting, see each printer 

manual. 

 8. Click the [Print Out] button. 

 

 

 9. The printout confirmation screen is 

displayed. 

 10. When you click [OK], printing starts.  

When the printing has finished, the 

[PRINTING] screen is closed 

automatically. 

When you click [Cancel], the system 

returns to Step 7 of this paragraph. 

 

KCA-SF-98D 
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■ 2.7 Terminating the KCA–SF–98D 

 Let's terminate the KCA–SF–98D software. 

 1. Click [File (F)] on the menu bar. 

 2. Select and click [Exit (X)] from the 

command list. 

 * If data not saved is present, a 

message for conformation is displayed. 

 

 

■ 2.8 Tool Buttons 

 The menu items which are used frequently are arranged as the tool buttons on the upper side of the 

screen. 

The menu which is executed when you click the button and the reference paragraph in this manual 

are shown below. 

 [File (F)] – [New (N)]  See Para. 4.2.1. 

 

 [File (F)] – [Open (O)]  See Para. 4.2.2. 

 

 [File (F)] – [Save (S)]  See Para. 4.2.4. 

 

 [File (F)] – [Print (P)]  See Para. 4.2.7. 

 

 [Option (O)] – [Register Group (G)]  See Para. 4.6.1. 

 

 [Tool (T)] – [Syntax Check (G)]  See Para. 4.4.2. 

 

 [Operation (C)] – [Run (R)]  See Para. 4.5.2. 

 

 [Operation (C)] – [Monitor(M)]  See Para. 4.5.3. 

 

 [Operation (C)] – [Send to Controller (D)]  See Para. 4.5.4. 

 

 [Operation (C)] – [Receive from Controller (U)]  See Para. 4.5.5. 

 

 [Operation (C)] – [Online Edit (O)]  See Para. 4.5.6. 

 

 [Option (O)] – [System Environment (E)]  See Para. 4.6.2. 
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Chapter 3 File Editing 

 

■ 3.1 How to Open and Close File Editing Screen 

 

■ 3.1.1 How to Open 

 To open the file editing screen, you can select one of the following five (5) manners. 

 • Click [File] – [New] from the [File] menu.  (See Para. 4.2.1.) 

 • Click the [   ] button on the tool bar.  (See Para. 4.2.1.) 

 • Click [File] – [Open] from the [File] menu.  (See Para. 4.2.2.) 

 • Click the [   ] button on the tool bar.  (See Para. 4.2.2.) 

 • Click [File] – [Import] from the [File] menu.  (See Para. 4.2.6.) 

 * You cannot open the parameter file by clicking [File] – [New]. 

Additionally, you can open only the two (2) types of data (i.e., sequential program and point 

table) in the [Import]. 

 

■ 3.1.2  How to Close 

 Click [File] – [Close] from the [File] menu, or click the [X] button on the upper right of the editing 

screen.  Then the file editing screen closes.  (See Para. 4.2.3.) 
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■ 3.2 Editing Sequential Program 

 The sequential program is the most popularized program where you can control the robot by writing 

instruction words under respective step numbers. 

When the setting of the controller is KCA-01-M05, Editing sequential program is not valid. 

 

■ 3.2.1 Structure of Sequential Program Editing Screen 

 

 

 

 

 [1] Program code default display column 

Displays the format of an instruction word. 

You can change over the default display by clicking [Tool] – [Code-Display On(Off)] of the 

menu bar. 

For details, see Para. 4.4.4. 

 [2] Edit range 

Displays the step range of the sequential program, which can be edited. 

To change the edit range, click [Tool] – [Set Range] of the menu bar. 

For details, see Para. 4.4.1. 

 [3] Edit mode display 

Indicates whether input through the keyboard is done in the “insert” mode or “overwrite” 

mode.`` 

[1] [2] [3] [4] 

[5] 
[6] [7] 

[8] [9] 
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 * You can change over the insert mode and overwrite mode by means of the "Insert" key on the 

keyboard. 

 [4] Task No. setting box 

Displays the task number of the sequential program, which you are editing now. 

To change the task number, select a desired task number from the dropdown list of “Task No.”. 

 [5] Step No. 

Displays the step numbers in the edit range lengthwise. 

 [6] Program code (instruction word) input column 

Enter the sequential program in this column. 

 [7] Comment column 

You can enter a comment here. 

 [8] A group of instruction words 

The instruction words used for editing the sequential program are arranged in the alphabetical 

order. 

 [9] "Group of instruction words" changeover buttons (+, –) 

Changes over the group of instruction words. 
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■ 3.2.2 Editing Sequential Program 

 Program input 

To input a program, set the cursor to the program code input column of a desired step number and 

input an instruction word. 

 Entry of an instruction word comes in the two (2) types; using a group of instruction words shown on 

the bottom side of the sequential editing screen and input of an instruction word directly through the 

keyboard. 

When you use a group of instruction words, change over the display of "a group of instruction 

words" by clicking the changeover button (+, –), followed by the instruction word button you wish to 

input.  Then the instruction word and the initial value of its parameter are input under the program 

code input column where the cursor is seated.  You can edit the parameter value at your discretion. 

When you enter an instruction word directly through the keyboard, set ON the program code default 

display column.  When you enter an instruction word followed by a space, the default parameter of 

this instruction word is displayed in the program code default display column.  Enter the parameter 

value, referring to the value then. 

 * Enter the instruction word in single-byte capital letters. 

For the parameters, discrimination of capital letters from small letters is necessary.  Refer to 

the program code default display column. 

 When you press the "Enter" key, the input completes and the cursor moves to the comment column. 

 To correct the character, delete it by the "BS" key or "Del" key by moving the cursor, then input a 

new character.  Or press the "Ins" key to select the overwrite mode and overwrite the character. 

 To replace an instruction word of some step number with another instruction word, set the cursor to 

this step, and select and click a desired instruction word from a group of instruction words.  Then 

the instruction word is overwritten under the current step number. 

 The meaning of the main parameters is given below. 

For the other parameters, see the descriptions on each command described in the controller 

instruction manual. 
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Parameter Meaning  Parameter Meaning 

CN Counter number  STN Station number 

TN Timer number  PN I/O port number 

TAG Tag number  TM Timer value 

TA Task number  GRP Group number 

 

 Input of coordinate value 

Entry of a coordinate value comes in the three (3) types; MDI teaching (i.e., direct input through the 

keyboard), remote teaching and direct teaching. 

When you use the MDI teaching function, you can omit a plus (+) sign preceding a numerical value 

and a leading zero (0). 

The number of digits of coordinate value you can input is four (4) digits for the integer and two (2) 

digits for the decimal. 

When you use the remote teaching or direct teaching function, click [Tool] – [Coordinate Entry] of 

the menu bar, and the teaching screen is called on the display, where you can input a coordinate 

value. 

For further information, see Para. 4.4.3. 

 [Edit] menu 

You can execute the following commands from the [Edit] menu of the menu bar. 

 Undo, Redo (See Para. 4.3.2.) 

Line Insert (See Para. 4.3.3.) 

Line Delete (See Para. 4.3.4.)  

Program Clear (See Para. 4.3.7.) 

Cut, Copy, Paste (See Para. 4.3.8.)  

Step Search (See Para. 4.3.11.) 

Tag Search (See Para. 4.3.12.)  

I/O usages (See Para. 4.3.15.) 

 

 Program check 

Click [Tool] – [Syntax Check] of the menu bar, and you can perform check and automatic correction 

of the described program. 

For details, see Para. 4.4.2. 
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■ 3.3 Editing Palletizing Program 

 The palletizing program is an exclusive program for allowing the robot to move and load a pallet.  All 

you have to do is setting the relevant parameters. 

When the setting of the controller is KCA-01-M05, Editing palletizing program is not valid. 

 

■ 3.3.1 Structure of Palletizing Editing Screen 

 

 

 

 

 

 [1] “Prg.” column 

Selects the palletizing program number. 

Enter the program number directly to the “Prg.” column, or select the program number by 

using the arrow-mark buttons shown on the right side. 

 [2] Edit range 

Displays the edit range of the palletizing program. 

To change the edit range, click [Tool] – [Set Range] of the menu bar. 

For details, see Para. 4.4.1. 

[1] [2] 

[3] 

[4] 

[5] 
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 [3] Edit items 

The palletizing program consists of sixteen (16) items when the controller serves as a 

enhanced master unit.  It is comprised of fourteen (14) items when the controller serves as a 

master unit. 

The contents of each item are shown below. 

 

Step No. Enhanced master unit Master unit 

1 Start tag No. and mode Start tag No. and mode 

2 Home point coordinate value on S-side Home point coordinate value on S-side 

3 P1 coordinate value on S-side P1 coordinate value on S-side 

4 P2 coordinate value on S-side P2 coordinate value on S-side 

5 P3 coordinate value on S-side No. of points on S-side 

6 No. of points on S-side Approach from S-side to D-side 

7 Approach from S-side to D-side Hand tag No. on S-side 

8 Hand tag No. on S-side Home point coordinate value on D-side 

9 Home point coordinate value on D-side P1 coordinate value on D-side 

10 P1 coordinate value on D-side P2 coordinate value on D-side 

11 P2 coordinate value on D-side No. of points on D-side 

12 P3 coordinate value on D-side Approach from D-side to S-side 

13 No. of points on D-side Hand tag No. on D-side 

14 Approach from D-side to S-side End tag No. 

15 Hand tag No. on D-side — 

16 End tag No. — 

 

 [4] Program edit column 

You can edit each item of the palletizing program. 

 [5] Comment column 

You can enter a comment here. 
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■ 3.3.2 Editing Palletizing Program 

 Program input 

To input a program, click the program edit column of a desired edit item.  Then the item you have 

clicked can be edited. 

For the item having choices such as M–1 and 1–M, double-click the relevant characters or press the 

space key.  The choice is changed over and displayed then. 

 

Mode (M–1  1–M  M–M) 

a (Absolute)  i (Relative) 

S (Axis speed)  T (Linear speed) 

POST (Position)  PASS (Pass point) 

 

 Enter a numerical value other than the coordinate value directly through the keyboard. 

When you press the "Enter" key, the input completes and the cursor moves to the next item. 

 Input of coordinate value 

Entry of a coordinate value comes in the three (3) types; MDI teaching (i.e., direct input through the 

keyboard), remote teaching and direct teaching. 

When you use the MDI teaching function, you can omit a plus (+) sign preceding a numerical value 

and a leading zero (0). 

When you use the remote teaching or direct teaching function, click [Tool] – [Coordinate Entry] of 

the menu bar, and the teaching screen is called on the display, where you can input a coordinate 

value. 

For further information, see Para. 4.4.3. 

 [Edit] menu 

You can execute the following commands from the [Edit] menu of the menu bar. 

 Cut, Copy, Paste (See Para. 4.3.8.) 

Select All, (See Para. 4.3.9.) 
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 Input of subroutine program 

When you specify the subroutine program tag of Start, Hand or End, you can jump to the step of the 

tag number written in the sequential program and execute its subroutine. 

 * When the tag number is "000", the controller passes without doing any operation. 

 Enter the subroutine program on the sequential program editing screen. 

Specify the same tag number as the tag number used for specifying the subroutine at the top of the 

program, and the RET (return) command at the end of the program. 

 

■ 3.4 Editing Easy Program 

 The easy program cannot be used since version 5.0.0. 
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■ 3.5 Editing Point Table 

 Coordinates when the robot starts and stops can be registered in the table as shown below. 

Refer to [3.12 Editing Point Table] for editing point table of KCA-01-M05. 

 

■ 3.5.1 Structure of Point Table Editing Screen 

 

 

 

 

 [1] Edit range 

Displays the table range of the point table, which can be edited. 

To change the edit range, click [Tool] – [Set Range] of the menu bar. 

For details, see Para. 4.4.1. 

 [2] Task No. setting box 

Displays the task number of the point table, which you are editing now. 

To change the task number, select a desired task number from the dropdown list of “Task No.”. 

 [3] Table No. 

Displays the step numbers in the edit range lengthwise. 

[1] [2] 

[3] 

[4] 

[5] 
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 [4] Coordinate Entry column 

You can enter a coordinate value here. 

  * A1 to A4 signify the axis 1 to axis 4, respectively. (For enhanced master unit) 

 [5] Comment column 

You can enter a comment here. 

 

■ 3.5.2 Editing Point Table 

 Input of coordinate value 

 When you click an item of the Coordinate Entry column, where you wish to input by using the mouse, 

the item is selected and you can enter a coordinate value there.  When you press the "Enter" key 

after you have input a numerical value, the next item is selected. 

 Entry of a coordinate value comes in the three (3) types; MDI teaching (i.e., direct input of the robot 

coordinates through the keyboard), remote teaching and direct teaching. 

When you use the MDI teaching function, you can omit a plus (+) sign preceding a numerical value 

and a leading zero (0). 

The number of digits of coordinate value you can input is four (4) digits for the integer and two (2) 

digits for the decimal. 

When you use the remote teaching or direct teaching function, click [Tool] – [Coordinate Entry] of 

the menu bar, and the teaching screen is called on the display, where you can input a coordinate 

value. 

For further information, see Para. 4.4.3. 

 [Edit] menu 

You can execute the following commands from the [Edit] menu of the menu bar. 

 Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.)  

Search (See Para. 4.3.13.) 
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■ 3.6 Editing MVM Table 

 The palletizing program described in Para. 3.3 allows the robot to perform palletizing operation when 

you only set various data without using any instruction. 

Due to moded palletizing operation, however, the degree of freedom of motions is restricted to some 

extent.  In the sequential program using MVM command, the degree of freedom of motions becomes 

higher and complex palletizing motions (1 to M, M to 1, sequential movement on matrix, etc.) are 

possible to compensate for the defects of the palletizing program. 

When the setting of the controller is KCA-01-M05, Editing MVM table is not valid. 

 

■ 3.6.1 Structure of MVM Table Editing Screen 

 

 

 

 [1] “Table” column 

Select the MVM table number. 

Enter the table number directly to the “Table” column, or select the table number by using the 

arrow-mark buttons shown on the right side. 

 [2] Edit range 

Displays the edit range of the MVM table. 

To change the edit range, click [Tool] – [Set Range] of the menu bar. 

For details, see Para. 4.4.1. 

 [3] Edit items 

The MVM table consists of five (5) items when the controller serves as a enhanced master 

unit.  It is comprised of three (3) items when the controller serves as a master unit. 

The contents of each item are shown below. 

  

[1] [2] 

[3] 
[4] 

[5] 
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Step No. Description 

1 Point table number covering matrix origin (ORG), P1 to P2 (P3) 

2 No. of points between P1 and P2 (P3) 

3 Counter number from P1 to P2 (P3) 

4 Z-axis, R-axis approach point (for enhanced master unit only) 

5 R-axis destination point (for enhanced master unit only) 

 

 [4] Table edit column 

You can edit each item of the MVM table. 

 [5] Comment column 

You can enter a comment here. 
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■ 3.6.2 Editing MVM Table 

 Input of table contents 

To input the table contents, click the edit column of a desired edit item.  Then the item you have 

clicked can be edited. 

For the item having choices (Step No.4), double-click the relevant characters, and the choice is 

changed over and displayed then. 

 

a (Absolute)  i (Relative) 

 

 Enter a numerical value other than the coordinate value directly through the keyboard. 

When you press the "Enter" key, the input completes and the cursor moves to the next item. 

 Input of coordinate value 

Entry of a coordinate value comes in the three (3) types; MDI teaching (i.e., direct input through the 

keyboard), remote teaching and direct teaching. 

When you use the MDI teaching function, you can omit a plus (+) sign preceding a numerical value 

and a leading zero (0). 

 When you use the remote teaching or direct teaching function, click [Tool] – [Coordinate Entry] of 

the menu bar, and the teaching screen is called on the display, where you can input a coordinate 

value. 

For further information, see Para. 4.4.3. 

 Edit range 

Displays the edit range of the MVM table. 

To change the edit range, click [Tool] – [Set Range] of the menu bar. 

For details, see the descriptions on [Set Range]. 

 [Edit] menu 

You can execute the following commands from the [Edit] menu of the menu bar. 

 Cut, Copy, Paste (See Para. 4.3.8.) 

Select All (See Para. 4.3.9.) 
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■ 3.7 Editing Speed and Acceleration/Deceleration Table 

 The speed table registers the travel speeds of the robot. 

The acceleration/deceleration table registers the time until the speed reaches the predetermined 

speed. 

 

■ 3.7.1 Structure of Speed and Acceleration/Deceleration Table Editing Screen 

 

 [1] Table select button 

When you click the option button, you 

can change over the speed table 

editing screen or 

acceleration/deceleration table editing 

screen. 

 • Speed table 

 [2] Speed table No. 

Displays the speed table numbers 

lengthwise. 

The speed table edit range is 1 

through 20 when the setting of the 

controller is KCA-25-M10/M40 /M80. 

When the setting of the controller is 

KCA-01-M05, the range is 1 through 

8. When the setting of the controller is 

the others, the range is 1 through 10. 

 [3] Speed setting column 

Specify the speed under the column 

of “(mm/s)”. 

 

 

 

  

[1] 

[2] 
[3] 

[6] 
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 • Acceleration/deceleration table 

 [4] Acceleration/deceleration table No. 

Displays the acceleration/ 

deceleration table numbers 

lengthwise. 

The acceleration/deceleration table 

edit range is 1 through 20. 

When the setting of the controller is 

KCA-01-M05, the range is 1 through 

8. 

 [5] Acceleration/deceleration table 

editing screen 

Specify the acceleration/ deceleration 

under the column of “(s)”. 

 [6] Comment column 

You can enter a comment here. 

 

 

 

 

[1] 

[4] [5] 

[6] 
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■ 3.7.2 Editing Speed and Acceleration/Deceleration Table 

 Table changeover 

The speed table and acceleration/deceleration table are contained in the same editing screen.  To 

change over the speed table editing or acceleration/ deceleration table editing, click the table select 

button. 

 Input of numerical value (speed table) 

When you click a desired item where you wish to input data by using the mouse, the item is selected 

and you can enter a numerical value there through the keyboard. 

The number of digits of speed you can input is four (4) digits for the integer and one (1) digit for the 

decimal.  The unit is "mm/sec". 

You can omit a leading zero (0). 

 Input of numerical value (acceleration/deceleration table) 

When you click a desired item where you wish to input data by using the mouse, the item is selected 

and you can enter a numerical value there through the keyboard. 

The number of digits of acceleration or deceleration you can input is one (1) digit for the integer and 

two (2) digits for the decimal.  The unit is "sec". 

 [Edit] menu of speed table 

You can execute the following command from the [Edit] menu of the menu bar. 

 Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.) 

 [Edit] menu of acceleration/deceleration table 

You can execute the following command from the [Edit] menu of the menu bar. 

 Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.) 
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■ 3.8 Editing Robot Type 

 The robot type editing screen allows the robot type editing. 

The correct robot type is input automatically by selecting an axis model. 

 

■ 3.8.1 Structure of Robot Type Editing Screen 

 

 

 

 

 

 

 

 

 

 [1] Robot type setting column 

Specify the robot type. 

 [2] Axis number button 

A1 to A4 represent the axis 1 to axis 4, respectively. (For enhanced master unit) 

When you click the axis number button, the [ROBOT TYPE SELECT] screen of the clicked 

axis open. 

The [ROBOT TYPE SELECT] screen is explained at next page. 

You cannot click it in case of [KCA-25-M10/M40/M80]. 

 [3] Comment column 

You can enter a comment here. 

 

[1] 

[2] [3] 
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■ 3.8.2 Editing Robot Type 

 Input of robot type 

Click a set item you wish to edit, using the mouse and enter a new value. 

Enter a numerical value in the MDI teaching mode. The number of digits of coordinate value you 

can input is six (6) digits for the integer. 

You can execute the following command from the [Edit] menu of the menu bar. 

Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.) 

 

And when you click the axis number button, the [ROBOT TYPE SELECT] screen of the clicked axis 

open. By selecting the axis model at this screen, the robot type is set automatically. 

You cannot set robot type at the [ROBOT TYPE SELECT] screen in case of 

[KCA-25-M10/M40/M80]. 

 

 

 

 

 

 

 

 

 

 

 

 [1] Dropdown list for robot type select 

select an axis model from the dropdown list from the left sequentially. 

 [2] Check box for robot type select Check the [Travel Type Axis] check box in case of a travel 

type axis. 

When an axis model is selected, in case of the axis that the travel type cannot be selected for, 

the check box is disable.  

 [3] OK button 

The [ROBOT TYPE SELECT] screen close, the robot type of the selected axis is input at the 

robot type setting column of robot type editing screen. 

And the selected axis model is input automatically at the comment column. 

 [4] CANCEL button 

The [ROBOT TYPE SELECT] screen close, and the system returns to the robot type editing 

screen. 

 

[1] 

[4] [3] 

[2] 
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■ 3.9 Editing Parameter 1 

 The parameter 1 editing screen allows the mode editing and parameter 1 editing. 

As the parameter 1 edit items include the parameter which bans the robot from moving if a value other 

than the specified range is entered, the parameter 1 cannot be created newly. 

To edit the parameter 1, receive it once from the controller and edit. 

 

■ 3.9.1 Structure of Parameter 1 Editing Screen 

 • Mode setting sheet 

 

 

 

 [1] Edit item select tab 

The parameter 1 editing screen consists of the two (2) sheets; mode setting sheet and 

parameter 1 setting sheet. 

To select the mode setting sheet, click the [Mode] tab.  To select the parameter 1 setting 

sheet, click the [Parameter1] tab. 

 [2] Set items 

The items that can be set on the mode setting sheet are displayed. 

[5] Setting screen is 

displayed here. 

[1] 

[2] 

[3] 

[4] [6] [7] 

[8] 
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 [3] Set contents 

The set contents of each item are displayed. 

 [4] Setting screen display button 

When you click this button, you can call the setting screen of a selected set item. 

 

 [5] Setting screen 

You can perform setting of each item. 

The setting screen differs with each set item.  

Use the option buttons to perform setting. 

 [6] [SET] button 

The set contents change to those as set on 

the setting screen. 

 

 

 [7] [CANCEL] button 

The contents as changed on the setting 

screen are invalid, and the set contents 

remain unchanged. 

[5]  Setting screen 

 [8] Comment column 

You can enter a comment here.  The comment can be input for each item. 



3-22 

 • Parameter 1 setting sheet 

 

 

 

 

 [9] Set items 

The items that can be set on the parameter 1 setting sheet are displayed. 

 [10] Axis display 

A1 to A4 represent the axis 1 to axis 4, respectively. (For enhanced master unit) 

 [11] Numerical value input column 

Perform setting of each item. 

[1] 

[9] 

[8] 

[10] 

[11] 
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■ 3.9.2 Editing Parameter 1 

 • Mode setting sheet 

 Mode setting 

Display a set item you wish to edit by using the scroll bar. 

Double-click a desired item, or click the item followed by the setting screen display button [], 

and the setting screen is displayed according to the type of selected item. 

Perform setting on the setting screen, using the option buttons. 

After the setting has finished, click the [SET] button, and the set contents are updated. 

When you click the [CANCEL] button, the new setting becomes invalid with the setting screen 

closed. 

 • Parameter 1 setting sheet 

 Parameter 1 setting 

Click a set item you wish to edit, using the mouse and enter a new value. 

 Input of numerical value 

Enter a numerical value in the MDI teaching mode. 

You can omit a plus (+) sign preceding the numerical value and a leading zero (0).  The number 

of digits of coordinate value you can input is four (4) digits for the integer and two (2) digits for the 

decimal. 

 

 Setting of area output 

When you press the "Enter" key 

under the column of “AREA OUTPUT 

(Coordinates)” or “AREA OUTPUT 

(BIT)”, the “AREA OUTPUT” setting 

screen as shown right appears.  

Perform setting of the area output on 

this screen. 
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 • [Axis] column 

Specify the axis for which the area output is to be set. 

A1 to A4 signify the axis 1 to axis 4, respectively. 

 • [Coordinates] column 

Specify the coordinate for area output of the axis as designated under the [Axis] column.  

Also, select “=” or “=” by means of the option button. 

 • “Stn.”, “Port” and “Bit” columns 

Specify the station number [Stn.], port number [Port] and bit number [Bit] to be output, using 

the option buttons. 

 Click the [SET] button, and the area output is set. 
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■ 3.10 Editing Parameter 2 

 The parameter 2 editing screen allows the parameter 2 editing. 

As the parameter 2 edit items include the parameter which bans the robot from moving if a value other 

than the specified range is entered, the parameter 2 cannot be created newly. 

To edit the parameter 2, receive it once from the controller and edit. 

 

■ 3.10.1 Structure of Parameter 2 Editing Screen 

 • Axis Item 1 setting sheet 

 

 

 

 

 [1] Edit item select tab 

The parameter 2 editing screen consists of the three (3) sheets; [Axis Item1] setting sheet, 

[Axis Item2] setting sheet and [Multi Task] setting sheet. 

To select the [Axis Item1] setting sheet, click the [Axis Item1] tab.  Likewise, to select the 

[Axis Item2] setting sheet, click the [Axis Item2] tab.  To choose the [Multi Task] setting sheet, 

click the [Multi Task] tab. 

 [2] Set items 

The items that can be set on the [Axis Item1] setting sheet are displayed. 

 [3] Set contents 

The set contents of each item are displayed. 

[5] Setting screen is 

displayed here. 

[1] 

[2] 
[3] 

[4] [6] [7] 

[8] 



3-26 

 [4] Setting screen display button 

When you click this button, you can call the setting screen of a selected set item. 

 

 [5] Setting screen 

You can perform setting of each item. 

The setting screen differs with each set item.  

Use the option buttons to perform setting. 

 [6] [SET] button 

The set contents change to those as set on 

the setting screen. 

 

 

[5] Setting screen 

 [7] [CANCEL] button 

The contents as changed on the setting screen are invalid, and the set contents remain 

unchanged. 

 [8] Comment column 

You can enter a comment here.  The comment can be input for each item. 
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 • [Axis Item2] setting sheet 

 

 

 

 

 [9] Set items 

The items that can be set on the [Axis Item2] setting sheet are displayed. 

 [10] Axis display 

A1 to A4 represent the axis 1 to axis 4, respectively. (For enhanced master unit) 

 [11] Numerical value input column 

Perform setting of each item. 

[1] [10] 

[9] 

[8] [11] 
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 • [Multi Task] setting sheet 

 

 

 

 

 [12] Set items 

The items that can be set on the [Multi Task] setting sheet are displayed. 

 [13] Task display 

Task 1 to task 4 are displayed. 

[1] [10] 

[13] 

[11] 

[8] 

[12] 
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■ 3.10.2 Editing Parameter 2 

 • [Axis Item1] setting sheet 

 [Axis Item1] setting 

Double-click a desired item, or click the item followed by the setting screen display button [], 

and the setting screen is displayed according to the type of selected item. 

Perform setting on the setting screen, using the option buttons. 

After the setting has finished, click the [SET] button, and the set contents are updated. 

When you click the [CANCEL] button, the new setting becomes invalid with the setting screen 

closed. 

 • [Axis Item2] setting sheet 

 [Axis Item2] setting 

Click a set item you wish to edit, using the mouse and enter a new value. 

 Input of numerical value 

Enter a numerical value in the MDI teaching mode. 

You can omit a plus (+) sign preceding the numerical value and a leading zero (0).  The number 

of digits of coordinate value you can input is four (4) digits for the integer and two (2) digits for the 

decimal. 

 • [Multi Task] setting sheet 

 [Multi Task] setting 

Click a set item you wish to edit, using the mouse and enter a new value. 

 Input of numerical value 

Enter a numerical value in the MDI teaching mode. 

You can omit a leading zero (0) of the numerical value. 

 

 

■ 3.11 Editing Parameter 3 

 The parameter 3 cannot be used since version 5.0.0. 
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■ 3.12 Editing Point Table (for KCA-01-M05) 

 The point table editing screen allows the point table editing. 

* Only when the setting of the controller is KCA-01-M05, Editing point table is valid. 

 

■ 3.12.1 Structure of Point table (KCA-01-M05) Editing Screen 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Scroll to the right 

[1] 

[4] 

[5] 

[2] [3] 

[4] 

[3] 
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 [1] Point table No. 

Displays the point table numbers lengthwise. 

The point table edit range is 1 through 15.  

 [2] Set items 

The items that are common in normal operation and torque limit operation are 

displayed. 

 [3] Set items 

The items that are used in normal operation are displayed in the upper side. The 

items that are used in torque limit operation are displayed in the lower side. 

 [4] Numerical value input column 

Perform setting of each item. 

 [5] Comment column 

You can enter a comment here. 

 

■ 3.12.2 Editing Point Table (KCA-01-M05) 

 Input of numerical value 

Click a set item you wish to edit, using the mouse and enter a new value. Enter a numerical value in 

the MDI teaching mode. You can omit a plus (+) sign preceding the numerical value and a leading 

zero (0). The number of digits of coordinate value you can input is four (4) digits for the integer and 

two (2) digits for the decimal. 

You can execute the following command from the [Edit] menu of the menu bar. 

Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.) 

Setting of operation method 

When a numeric keypad is pushed in operation method column, operation method selection screen 

appears. Setting of operation method is performed in this screen. Specify normal operation or 

torque limit operation. 
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Setting of movement mode 

When a numeric keypad is pushed in movement mode column, movement mode selection screen 

appears. Setting of operation method is performed in this screen. 

•ABS/INC movement 

 Specify absolute movement or incremental movement.  

•Aging 

 Specify aging operation is on or off. 

 

 

 

 

 

 

 

 

Setting of torque limit option 

When a numeric keypad is pushed in trq limit option column, torque limit option selection screen 

appears. Setting of torque limit option is performed in this screen. •Torque limit end 

 Specify torque limit end is on or off.  

•Lock end 

 Specify lock end is on or off.  

•Arrival end 

 Specify torque limit end is on or off.  

•Deviation detection 

 Specify positional deviation exceeded detection is on or off. 
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■ 3.13 Editing Torque Limit and Area Table 

 The torque limit and area table editing screen allows the torque limit and area table editing. 

* Only when the setting of the controller is KCA-01-M05, Editing torque limit and area table is valid. 

 

■ 3.13.1 Structure of Torque Limit and Area Table Editing Screen 

 •Torque limit table editing screen 

  

 

 

 

 

 

 

 

 

 

 

 [1] Table select button   

When you click the option button, you can change over the torque limit table editing screen or 

area table editing screen. 

 [2] Torque limit table No. 

Displays the torque limit table numbers lengthwise. 

The torque limit table edit range is 1 through 8.  

 [3] Set items 

The items that can be set on the torque limit table are displayed. 

 [4] Numerical value input column 

Perform setting of each item. 

 [5] Comment column 

You can enter a comment here. 

 

  

[2] [4] 

[1] [3] 

[5] 



3-34 

•Area table editing screen 

 

 

 

 

 

 

 

 

 

 

 [6] Area table No. 

Displays the area table numbers lengthwise. 

The area table edit range is 1 through 8.  

 [7] Set items 

The items that can be set on the area table are displayed. 

  

■ 3.13.2 Editing Torque Limit and Area Table 

 Table changeover 

The torque limit table and area table are contained in the same editing screen.  

To change over the torque limit table editing or area table editing, click the table select button. 

Input of numerical value 

Click a set item you wish to edit, using the mouse and enter a new value. Enter a numerical value 

in the MDI teaching mode. You can omit a plus (+) sign preceding the numerical value and a 

leading zero (0). The number of digits of coordinate value you can input is four (4) digits for the 

integer and two (2) digits for the decimal.  

You can execute the following command from the [Edit] menu of the menu bar. 

Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.) 

 

  

[6] [4] 

[1] [7] 
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Setting of comparison condition 

When a numeric keypad is pushed in comparison condition column, comparison condition 

selection screen appears. Setting of comparison condition is performed in this screen.  

Specify one from the three of [coordinate1 <= position <= coordinate2] and [position <= 

coordinate1] and [position >= coordinate1]. 
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■ 3.14 Editing Torque Limit Table 

 The torque limit table editing screen allows the torque limit table editing. 

* Only when the setting of the controller is KCA-25-M10/M40/M80, Editing torque limit table is valid. 

 

■ 3.14.1 Structure of Torque Limit Table Editing Screen 

 •Torque limit table editing screen 

  

 

 

 

 

 

 

 

 

 

 

 [1] Torque limit table No. 

Displays the torque limit table numbers lengthwise. 

The torque limit table edit range is 1 through 8.  

 [2] Set items 

The items that can be set on the torque limit table are displayed. 

 [3] Numerical value input column 

Perform setting of each item. 

 [4] Comment column 

You can enter a comment here. 

 

[1] 

[3] 

[2] 

[4] 
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■ 3.14.2 Editing Torque Limit and Area Table 

 Input of numerical value 

Click a set item you wish to edit, using the mouse and enter a new value. Enter a numerical value 

in the MDI teaching mode.  

You can execute the following command from the [Edit] menu of the menu bar. 

Undo, Redo (See Para. 4.3.2.) 

Cut, Copy, Paste (See Para. 4.3.8.) 
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Chapter 4 Menu Bar 

 

■ 4.1 Details of Menu Bar Items 

 

■ 4.1.1 Start, Edit and Run Screens 

 This tool comprises the three (3) types of screen; start screen, edit screen and run screen, and the 

contents of commands of the menu bar which can be executed differ with each screen. 

The contents of the three (3) different screens are as follows: 

 Start screen 

The initial screen which appears where this tool was started. 

Neither a program, table or parameter is being edited, and program execution or monitor is not 

going on. 

 Edit screen 

A program, table or parameter is being edited. 

 Run screen 

A program sent to the controller is being executed, jog operation is being executed and they are 

being monitored. 

 Once this tool has started, the start screen prevails.  Then, when you wish to edit a program or 

table, or wish to execute a program, the edit screen or run screen can be called on the display, 

respectively. 

In other words, no program can be executed during editing.  Or no program can be edited during 

execution. 
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■ 4.1.2 Details of Menu Bar Items 

 The contents of commands of the menu bar which can be executed differ with each screen (start 

screen, edit screen and run screen). 

The table below shows the contents of commands of the menu bar when each screen is called on 

the display.  Mark "O" signifies the command that can be executed.  Mark "X" means the 

command that cannot be executed. 

Though the [Edit] various commands can be executed only on the edit screen, commands that can 

be executed differ further according to the file being edited.  For details, see Para. 4.3.1. 

 

Menu Command Start Edit Run 

[File] 

New O O X 

Open O O X 

Close X O X 

Save X O X 

Save As X O X 

Import O X X 

Print O O X 

End O O X 

[Edit] 
[Edit] various commands X O X 

* The contents of [Edit] commands differ with the file being edited. 

[Tool] 

Set Range X O X 

Syntax Check X O X 

Coordinate Entry X O X 

Code-Display On(Off) X O X 

[Operation] 

Emergency Stop Circuit Check O X X 

Run O X X 

Monitor O X X 

Send to Controller O X X 

Receive from Controller O X X 

Online edit O X X 
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Menu Command Start Edit Run 

[Option] 

Group Setting O O X 

System Environment O X X 

Set Robot Type O X X 

Controller Version O X X 

File Convert O X X 

Program Compare O X X 

Error History O X X 

Memory Initialization O X X 

[Window] 

Cascade X O O 

Horizontal Tile X O O 

Vertical Tile X O X 

[Help] About KCA-SF-98D O O O 
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■ 4.2 File 

 

■ 4.2.1 New 

 This command is used to create a new program or table. 

 Click [File] – [New] of the menu bar, or click 

the [ ] button on the tool bar. 

A window for selecting the program or table 

you wish to edit is displayed.  Select the 

desired one and click the [OK] button.  Then 

the selected program or table editing screen 

opens. 

 

 

 * As the Parameter 1, Parameter 2 and Parameter 3 include the parameters which prohibit the 

robot from moving if a value other than the specified range is entered, they cannot be created 

newly.  To edit the parameter, receive it once from the controller and edit. 

 * When any editing screens are not opened, 

the screen as shown right is displayed. 

Select the used controller and click the [OK] button. 

 

■ 4.2.2 Open 

 This command is used to edit the existing program or table. 

 Click [File] – [Open] of the menu bar, or click 

the [ ] button on the tool bar. 

A window for selecting the program, table or 

parameter you wish to edit is displayed.  

Select the desired one and click the [OK] 

button. 

Next, a window for specifying the file is 

displayed.  Specify the file you wish to edit 

and click the [Open] button.  Then the 

selected file editing screen opens.  

 

 

 

 

 

 

 

 

KCA-SF-98D 
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■ 4.2.3 Close 

 This command is used to close the active screen. 

 Click [File] – [Close] of the menu bar, and the 

editing screen closes. 

If the file contents have been changed, the 

system displays a message for confirming the 

saving.  When you wish to close the screen 

after saving, click [Yes]. 

 

 

 When you wish to close the screen without saving, click [No].  When you wish to return to the 

editing screen, click [Cancel]. 

When saving the newly created program or table, a window for specifying the file name is displayed.  

Specify the file name and click the [Save] button. 

 

 * When saving the sequential program, a 

message of [SYNTAX CHECK 

CONFIRMATION] is also displayed. 

When you wish to perform program 

check, click [Yes].  When you do not 

wish, click [No]. 

 

 

 

■ 4.2.4 Save 

 This command is used to save the contents of the active screen under the same file name as that 

when the file was opened. 

Click [File] – [Save] of the menu bar, or click the [ ] button on the tool bar, and the file is saved. 

 * When saving the sequential program, a message of [SYNTAX CHECK CONFIRMATION] is also 

displayed. 

When you wish to perform program check, click [Yes].  When you do not wish, click [No]. 
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■ 4.2.5 Save As 

 This command is used to save the contents of the active screen under a new file name. 

Click [File] – [Save As] of the menu bar, and a window for specifying the file name is displayed.  

Specify the file name and click the [Save] button. 

 * When saving the sequential program, a message of [SYNTAX CHECK CONFIRMATION] is also 

displayed. 

When you wish to perform program check, click [Yes].  When you do not wish, click [No]. 

 

■ 4.2.6 Import 

 

 It is possible to open a file with [.CSV] or 

[.TXT] extension as the sequential program 

file or point table file.  

 Click [File] – [Import] of the menu bar, and the 

[Select External file] screen appears.  Select 

[*.CSV] or [*.TXT] from the dropdown menu of 

“Files of type”, specify the file you wish to 

open under the column of “File name”, then 

click [Open]. 

Next, as the screen for specifying the file 

format is displayed, select either 

[SEQUENTIAL] or [POINT TABLE], and click 

the [OK] button. 

The external data file opens according to the 

specified file format. 

 When the external data file has been 

imported, the screen is as shown below. 

 

 

 

 

 

KCA-SF-98D 
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 • When the file with [.TXT] extension has been opened as the sequential file: 

 

 

 

 

 

 • When the file with [.CSV] extension has been opened as the point table file: 
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■ 4.2.7 Print 

 Click [File] – [Print] of the menu bar, or click the [ ] button on the tool bar.  Then the printing 

screen is displayed as shown below. 

 • Structure of printing screen 
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 [1] [Group Select] column 

  [Group] ····· Used to specify the group file. 

 [2] [Individual] column 

  [SEQUENTIAL] ····· Used to specify the sequential text file. 

  [PALLETIZING] ····· Used to specify the palletizing text file. 

  [EASY MODE] ····· Used to specify the easy text file. 

  [POINT TABLE] ····· Used to specify the point table file. 

  [MVM TABLE] ····· Used to specify the MVM table file. 

  [SPEED/ACCEL] ····· Used to specify the speed or acceleration/ 

deceleration table file. 

  [PARAMETER1] ····· Used to specify the parameter 1 file. 

  [PARAMETER2] ····· Used to specify the parameter 2 file. 

  [PARAMETER3] ····· Used to specify the parameter 3 file. 

  [TORQUE LIMIT/AREA 

TABLE] 

····· Used to specify the torque limit / area table file. 

  [TORQUE LIMIT TABLE] ····· Used to specify the torque limit table file. 

 [3] “Printing Title” column 

When you enter characters as the printing title under this column, they are printed on all 

pages. 

 [4] “File Name” column 

The file name and edit range of each file as selected under “Group Select” or “Individual” 

are displayed.  It is also possible to select printing ON or OFF of each file by setting ON or 

OFF the check box. 

 [5] [Print Out] button 

When the file or files you wish to print have been established, click the [Print Out] button.  

All files whose printing are specified by each check box are printed. 

 [6] [Close] button 

To close this screen, click the [Close] button. 

 [7] [Printer Setting] button 

To perform setting of the printer connected to the computer, click the [Printer Setting] button.  

Then the printer setting screen appears on the display. 
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 • Printer setting screen 

 

 [1] “Select Printer” column 

When two (2) or more printers are connected to the personal computer, select a printer you 

wish to use from the “Printer Name” list. 

When you click the [Property] button, the property of the selected printer is displayed. 

The set contents of the [Property] screen differ with the printer to be used. 

For the setting, see each printer instruction manual. 

 [2] [Page Range] column 

Set the printing range by using the option button. 

 [3] [Number of copies] 

Specify the number of copies to be printed. 

 [4] [OK] (or [Print]) button 

When you wish to make the setting operative, click the [OK] button.  Then the setting 

becomes effective with the printing screen closed. 

 

 [5] [Cancel] button 

When you wish to cancel the setting, click the [Cancel] button.  Then the changed setting 

becomes ineffective with the printing screen closed. 

 

  

[1] 

[2] [3] 

[4] 

[5] 
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 • How to print 

Firstly, specify the program or table file you wish to print from [Group Select] or [Individual]. 

When you select [Group Select], click the [Group] button.  When you choose [Individual], click 

a desired button signifying the program or table name.  Then the screen for specifying the file 

appears. 

Specify a file you wish to print and click the [Open] button. 

The specified file is displayed under [File Name] and a check mark is put to the “PRINTING” 

check box. 

To stop printing of the specified file, clear the check mark put to the “PRINTING” check box. 

  When the file or files you wish to print have been established, click the [Print Out] button.  All 

files whose printing are specified by each check box are printed. 

 

■ 4.2.8 End 

 Click [File] – [End] of the menu bar, or click the close [X] button on the upper right of the screen.  

Then this tool terminates. 

When you execute the [End] command on the edit screen, the screen for confirming the saving 

appears if the file contents have been changed. 

When you wish to close the screen after saving, click [Yes]. 

When you wish to close the screen without saving, click [No].  When you wish to return to the 

editing screen, click [Cancel]. 

When saving the newly created program or table, a window for specifying the file name is displayed.  

Specify the file name and click the [Save] button. 

 * When saving the sequential program, a message of [SYNTAX CHECK CONFIRMATION] is also 

displayed. 

When you wish to perform program check, click [Yes].  When you do not wish, click [No]. 
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■ 4.3 Editing 

 

■ 4.3.1 Details of Edit Commands 

 For the [Edit] various commands, commands which can be executed differ with the file currently 

edited. 

The table below shows the contents of the edit commands.  Mark "O" signifies the command that 

can be executed.  Mark "X" means the command that cannot be executed. 

 

Edit menu Program Table 

Seq. Pal.  Point MVM Spd. Pnt. Trq. 

Undo O X  O X O O O 

Line Insert O X  X X X X X 

Line Delete O X  X X X X X 

Insert By Line Number Range X X  X X X X X 

Delete By Line Number Range X X  X X X X X 

Program Clear O X  X X X X X 

Cut O O  O O O O O 

Copy O O  O O O O O 

Paste O O  O O O O O 

Select All X O  X O X X X 

         

Cancel Range Select X X  X X X X X 

Step Search (Search) O X  O X X X X 

Tag Search O X  X X X X X 

I/O usage O X  X X X X X 

 * The abbreviations shown on top of the above table signify as follows. 

   Seq. : Sequential program Pal. : Palletizing program 

   Esy. : Easy program Point : Point table 

   MVM : MVM table 

   Spd. : Speed and acceleration/deceleration table 

   Pnt. : Point table for “KCA-01-M05” 

   Trq. : Torque limit / Area table, Torque limit table 

  For the Parameter 1, Parameter 2 and Parameter 3, the [Edit] menu cannot be used. 
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■ 4.3.2 Undo, Redo 

 When you have input by mistake, click [Edit] – [Undo].  Then you can return before the input. 

When you have returned too much, click [Edit] – [Redo].  Then you can return after the input. 

 

■ 4.3.3 Line Insert 

 Click the step (or line) where you wish to insert, and show the cursor.  When you click [Edit] – [Line 

Insert], one (1) step (or line) is inserted there. 

 * The line where one (1) line has been inserted and the subsequent lines are shifted down in turn 

by one (1) line at a time.  If a command is described on the final line of the program, the [Line 

Insert] function cannot be used there. 

 

■ 4.3.4 Line Delete 

 When you click [Edit] – [Line Delete], you can delete the line where the cursor is located. 

 

■ 4.3.5 Insert By Line Number Range 

 This function cannot be used since version 5.0.0. 

 

■ 4.3.6 Delete By Line Number Range 

 This function cannot be used since version 5.0.0. 

 

■ 4.3.7 Program Clear 

 When you click [Edit] – [Program Clear], you can clear the entire program you are editing now. 
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■ 4.3.8 Cut, Copy and Paste (Editing of Characters) 

 

 [Cut] ····· While the range is selected, click [Edit] – [Cut].  Then the selected range is 

deleted and stored in the program internal buffer. 

   

 [Copy] ····· While the range is selected, click [Edit] – [Copy].  Then the selected range 

is stored in the program internal buffer. 

   

 [Paste] ····· When you click [Edit] – [Paste], the range stored in the buffer by the [Cut] or 

[Copy] function is inserted at the cursor position. 

 * These menu items correspond to the Windows shortcut keys (Ctl+X, Ctl+C, Ctl+V). 

 

■ 4.3.9 Select All 

When you click [Edit] – [Select All], All items you are editing are selected. 

 

 

■ 4.3.10 Cancel Range Select 

 This function cannot be used since version 5.0.0. 
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■ 4.3.11 Step Search (Editing of Sequential Program) 

 

 When you wish to move the cursor to a specified step 

of the program during editing of the sequential program, 

this step number search function is useful. 

When you click [Edit] – [Step Search], the “STEP No. 

SEARCH” screen appears.  Enter the step number to 

which you wish to move and click the [OK] button.  

Then the cursor moves to the specified step. 

 

 

 

■ 4.3.12 Tag Search 

 

 This function can be used only when editing the 

sequential program. 

When you wish to move the cursor to a specified 

tag of the program during editing of the sequential 

program, this tag number search function is 

useful. 

When you click [Edit] – [Tag Search], the “TAG 

No. SEARCH” screen appears.  Enter the tag 

number you wish to search under the column of 

“TAG No.”. 

 

 

 When you wish to search in the upward direction from the current cursor position, click “UPWARD 

SEARCH”.  When you wish to search in the downward direction from the current cursor position, 

click “DOWNWARD SEARCH”.  Then click the [OK] button. 

 If two (2) or more tag numbers are specified, each time you click the [OK] button, the cursor moves 

to the next tag. 

Unless the specified tag number is found in the program, a message saying that the specified tag 

No. is not found is displayed. 
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■ 4.3.13 Search (Editing of Point Table) 

 When you wish to move the cursor to a specified table 

number of the program during editing of the point table, 

this table number search function is useful. 

When you click [Edit] – [Table Search], the “TABLE No. 

SEARCH” screen appears.  Enter the table number to 

which you wish to move and click the [OK] button.  

Then the cursor moves to the specified table. 

 

 

 

■ 4.3.14 Search (Editing of Easy Program) 

 

■ 4.3.15 I/O usages 

This function can be used only when editing the sequential program. When you wish to know the 

I/O using in the program, this I/O usages function is useful. 

When you click [Edit] – [I/O usages], the “I/O usages” screen appears. 

The usage counts of every bit are displayed. 

When you click the count, the step Nos. where the bit is used are displayed in the right side of the 

screen. 

 

 

 

 

 

 

 

 

 

 

 When you wish to move the cursor to a specified step of 

the program during editing of easy program, this step 

number search function is useful. 

When you click [Edit] – [Search], the “STEP No. 

SEARCH” screen appears.  Enter the step number to 

which you wish to move and click the [OK] button.  

Then the cursor moves to the specified step. 
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■ 4.4 Tool 

 

■ 4.4.1 Set Range 

 

 You can specify the required range of each file.  Thus, 

you can avoid transmission and printing of unnecessary 

step or steps. 

* During editing of the point table, at least 16 rows are 

displayed. 

 Click [Tool] – [Set Range], and the “SET RANGE” 

screen appears. 

Enter the values under “START” and “END”, then click 

the [OK] button. 

 

 

 * During editing of the sequential 

program, the screen for confirming the 

range is displayed before setting the 

range.  When you wish to set the 

range, click [OK].  Otherwise, click 

[Cancel]. 

When the range has been changed, the 

described program may be deleted 

according to the changed value. 
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■ 4.4.2 Syntax Check 

 This function performs program check and automatic correction of the edited sequential program. 

Click [Tool] – [Syntax Check] of the menu bar, or click the [ ] button on the tool bar.  Then the 

“SYNTAX CHECK” screen is displayed as shown below. 

 • “SYNTAX CHECK” screen 

 

 

 

 [1] [File Name] column 

The file name of the sequential program subject to program check is displayed. 

 [2] [SYNTAX CHECK] button 

When you click the [SYNTAX CHECK] button, program check starts on the sequential 

program you are editing now. 

  The contents of the check are as 

follows: 

  • Search and check of instruction 

words 

  • Check on parameter 

descriptions 

  • Check on the number of space 

characters 

 

 

  The results of the check are shown on the [ERROR] screen. 

[1] 

[2] [3] [4] 
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 [3] [CORRECTION] button 

When you click the [CORRECTION] button, the “CORRECTION” screen appears. 

 [4] [CANCEL] button 

When you click the [CANCEL] button, you can return to the editing screen. 

 • [CORRECTION] screen 

 

 [1] [File Name] column 

The file name of the sequential 

program subject to automatic 

correction is displayed. 

 [2] “SYNTAX CHECK” check box 

When you check this check box 

beforehand, program check is 

performed on the same file after 

automatic correction. 

 

 

 

 [3] [OK] button 

When you click the [OK] button, automatic correction starts on the sequential text you are 

editing now. 

 [4] [CANCEL] button 

When you click the [CANCEL] button, the system returns to the “SYNTAX CHECK” screen. 

 * When you click [File] – [Print] while the screen of program check results is active, details of the 

error currently displayed are printed. 

[1] 

[2] [3] [4] 
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■ 4.4.3 Coordinate Entry 

 It is possible to input a coordinate value to the program or table by using the remote teaching or 

direct teaching function. 

 Before executing this operation, connect the personal computer with the robot controller and make 

the controller ready for the operation. 

Also, click [Operation] – [Emergency Stop Circuit Check], then click the [EXECUTION ENABLE] 

button beforehand.  Otherwise, you cannot enter the teaching screen.  (See Para. 4.5.1.) 

 • How to enter the teaching mode 

  At editing of sequential program: 

When the cursor is located in the step where MOV, MVC, OFS or RSMV command is input, click 

[Tool] – [Coordinate Entry]. 

  At editing of palletizing program and point table: 

When the cursor is located at the X coordinate, click [Tool] – [Coordinate Entry]. 

  Now, the “TEACHING MODE” screen is displayed. 

 • “TEACHING MODE” screen 

 

 

 

 

 

 

 

 

 

 

 

[1] 

[2] 
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 [1] “POINT MONITOR” 

Coordinates of the axis 1 to axis 4 are displayed real-time. 

 [2] “MODE” 

Select the travel speed when you click the “JOG”`button. 

Select either of [LOW], [HIGH] or [INCHING] by means of the option button. 

  [LOW] : Jog speed L (low speed) of Parameter 1.  The axis moves at the 

predetermined speed. 

  [HIGH] : Jog speed H (high speed) of Parameter 1.  The axis moves at the 

predetermined speed. 

  [INCHING] : The axis will not move continuously but moves only by the predetermined 

distance in the specified direction.  The travel distance per click can be 

specified by the inching distance of Parameter 1. 

 [3] “TEACH” 

Select the teaching mode. 

  Select the remote teaching mode or direct 

teaching mode by clicking the option button. 

If you have changed the teaching mode, a 

comment instructing change of the servo status 

is displayed.  Observe the instructions then. 

 

 

  Also, this button is interlocked with the servo status and changed over automatically. 

When the servo lock is selected, the remote teaching mode takes effect.  When the servo 

free is selected, the direct teaching mode becomes operative. 

 [4] “DIRECT” 

Used to turn on and off the general-purpose outputs as specified by “Direct Output” of 

Parameter 1. 

When you set the hand tool open/close signals, etc., in advance, you can turn them on and 

off through the jog screen during operation. 
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  The status in which the button under the column of [DIRECT] is depressed is ON and the 

initial status is OFF. 

 [5] “JOG” 

Used to move the axis in the remote teaching mode. 

When you click the button under the column of “JOG”, the axis moves at jogging in the 

specified direction at a speed selected by “MODE”. 

Signs "+" and "–" signify the axis travel direction, and the direction in which the distance 

from the home point increases is the "+" direction. 

Numbers 1 to 4 represent the axis 1 to axis 4, respectively. 

When [LOW] or [HIGH] of “MODE” is selected, the specified axis moves as long as the 

button is kept pressed.  In the [INCHING] mode, the specified axis moves only by the 

specified travel distance each time the button under [JOG] is clicked once. 

 [6] “SERVO” 

Used to change the servo status. 

  When you click the [FREE] button, the servo 

becomes free. 

When you click the [LOCK] button, the [SERVO 

LOCK] confirmation screen appears to assure 

safety. 
 

  When you click the [OK] button, the servo is locked. 

The buttons under the column of “SERVO” are interlocked with the buttons under the 

column of “TEACH”. 

 [7] “WRITE” 

Used to write a coordinate value. 

When you click the [WRITE] button, current coordinates shown in “POINT MONITOR” are 

written as the coordinate value. 

 [8] “CANCEL” 

Used to cancel a coordinate value written by coordinate teaching. 

When you click the [CANCEL] button, coordinates shown on the editing screen are replaced 

by those shown before the teaching screen was displayed. 
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 [9] “HOME” 

When you click the [HOME] button, the robot returns to the home position. 

During the home return, all buttons become inoperative. 

 [10] “CLEAR” 

When you click the [CLEAR] button, you can clear an error status at the time of error 

generation.  

 [11] “TASK No.” 

You can change the task No.  

by using the [CHANGE] button. 

 [12] “FREE”  

When you click the [FREE] button, the servo enters a free state. 

 [13] “LOCK” 

When you click the [LOCK] button,  

the [SERVO LOCK] confirmation screen  

is displayed to assure safety.  

When you click the [OK] button, the servo is locked. 

When you click the [CANCEL] button, the servo is not locked. 

 [14] “END” 

Used to terminate the teaching operation. 

When you click the [END] button, the teaching screen closes. 

 

■ 4.4.4 Code-Display On(Off) 

 When you click [Tool] – [Code-Display On], the default display column of instruction word and 

parameter is shown on the upper side of the editing screen. 

When you press the space key after entering an instruction word, using the button for instruction 

word or through the keyboard, the default value of the relevant instruction word is displayed. 

If you move the cursor to the line where an instruction word is already input, the default value of this 

instruction word is displayed. 

Enter each parameter value, referring to the contents of this display. 

When you click [Code-Display Off] of the [Tool] menu by using the mouse, this display column 

disappears. 

 • [Code-Display On(Off)] is effective only for editing of the sequential program. 
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■ 4.5 Robot Operation 

 

■ 4.5.1 Emergency Stop Circuit Check 

 To assure safety, the KCA–SF–98D prohibits the axis feed without executing the [Emergency Stop 

Circuit Check] command. 

 

 When you click [Operation] – [Emergency 

Stop Circuit Check], the “EMERGENCY 

STOP CONFIRMATION” screen appears 

on display.  Make sure that the emergency 

stop circuit check is connected, then click 

the [EXECUTION ENABLE] button. 

 

 

 * After making sure that the emergency stop circuit check is connected, a warning message is 

always displayed under the tool bar. 

 To command prohibition of the robot operation through the personal computer, click [Operation] – 

[Emergency Stop Circuit Check] from the menu bar in the same manner as above, then click 

[EXECUTION DISABLE].  Thus, the robot operation can be prohibited.  When this happens, the 

warning message is cleared. 
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■ 4.5.2 Run 

 When you click [Operation] – [Run] of the menu bar, or click the [ ] button on the tool bar, the 

program execution screen is displayed. 

Before executing this operation, connect the personal computer with the robot controller and make 

the controller ready for the operation. 

Also, before the [Run] command is executed, the [Emergency Stop Circuit Check] command should 

be executed. 

 * Don’t disconnect the communication cable before closing the program execution screen. 

* When you close the program execution screen during operation without CC-Link communication 

in case of the controller for CC-Link, the operation stops. 

 1. Execution screen of Enhanced master unit, Master unit 

 * The program run mode (initial setting) is determined with the controller mode effective when you 

have clicked [Run]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

[1] [2] [3] 

[4] 

[5] 

[6] 

[7] 

[8] 

[9] [10] [11] [12] [13] [14] [15] [16] [17] [25] 
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 [1] [Operation Mode] 

Select the AUTO mode or STEP mode for program execution by using the option button 

under the column of “Operation Mode”. 

* When the external point designation mode “EXPOINT DESIGNATION” is 

selected for the program mode, “STEP” is always selected for “Operation 

Mode”. 

 [2] [Program Mode] 

Select the type of the program you wish to 

execute. 

When you click the [SELECT] button under the 

column of “Program Mode”, the “RUN MODE 

SELECTION” screen appears on the display. 

Select either of the sequential mode 

“SEQUENTIAL”, palletizing mode 

“PALLETIZING”, external point designation 

mode “EXPOINT DESIGNATION” or easy 

mode “EASY” by means of the option button, 

and click the [OK] button. 

 

 

*When the setting of the controller is KCA-25-M10/M40, “EASY” is not represented. 

 [3] [SEARCH] 

When you click the [SEARCH] button, the 

“SEARCH” screen is called on the display. 

Either of the following is searched according to 

the program run mode selected then. 

 

  • Sequential mode ····· Search of step number 

  • Palletizing mode ····· Search of program number 

  • Easy mode ····· Search of program number 

  • External point designation mode 

 ····· Search of table number 
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 [4] [RSMV] (only for enhanced master 

unit) 

When you click the [RSMV] button, 

the “RSMV SIMULATION” screen is 

called on the display. 
 

  When you have executed the RSMV command of the SEQUENTIAL mode, enter the 

coordinates through this screen. 

  • [A1] ~ [A4] 

Enter the coordinates you wish to transmit. 

A1 to A4 signify the axis 1 to axis 4, respectively, and only relative coordinates can be 

specified.  Also, only the [POST] (position) mode can be specified for the RSMV 

command. 

  • [SPEED TABLE No.] 

Specify the speed table number. 

  • [START] button 

Used to start entering coordinates. 

  • [END] button 

Used to close the [RSMV SIMULATION] screen. 

 [5] [END] 

When you click the [END] button, the program execution screen closes. 

 [6] Step monitor column 

Currently executed program step monitor is displayed. 

For details, see Para. 4.5.3. 

 [7] [MONITOR] 

When you click the [MONITOR] button, you can see various monitoring. 

For details, see Para. 4.5.3. 
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 [8] [RESET] 

When you click the [RESET] button, you can reset the step numbers of the sequential 

program and easy program and counters of the palletizing program. 

Some may not be reset according to the setting of the continuous start mode, however. 

For details, see the descriptions on continuous start input carried in the controller instruction 

manual provided separately. 

 

 [9] [OVER RIDE] 

When you click the [OVER RIDE] button, the 

“OVER RIDE” setting screen is displayed. 

  • [NOW VALUE] 

Displays the currently set override value. 

  • [SETTING VALUE] 

Enter the override value in the setting 

column, or set the override value by using 

the scroll bar. 

  • [OK] button 

When you click the [OK] button, the 

override value you just entered is set. 

  • [CANCEL] button 

When you click the [CANCEL] button, the 

“OVER RIDE” screen closes and the 

override value effective before the setting 

remains. 
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 [10] DIRECT OUT 

It is possible to manually output any bits. 

When you click the [DIRECT OUT] button, the 

“DIRECT OUTPUT” screen is displayed. 

Specify the values for “STATION No.”, “PORT 

No.” and “BIT PATTERN” and click the [OK] 

button, and the output bits of the specified 

general-purpose output are turned on. 

To close the “DIRECT OUTPUT” screen, click 

the [CANCEL] button. 

* ”1” means on, “0” means off, “.” means the 

current output state is kept. 

 

 

 

  [11]  [FREE] 

       When you click the [FREE] button, the servo enters a free state. 

 

 [12] [LOCK] 

When you click the [LOCK] button, the [SERVO 

LOCK] confirmation screen is displayed to 

assure safety. 

When you click the [OK] button, the servo is 

locked. 

When you click the [CANCEL] button, the servo 

is not locked. 

 

 

 [13] [HOME] 

When you click the [HOME] button, the robot returns to the home point. 

During the home return, all buttons become inoperative. 

 [14] [JOG] 

The jog operation means the manual axis feed during program execution or stop.  When 

you click the [JOG] button, the “JOG MODE” screen is called on the display. 

For the “TEACHING MODE” screen, see Para. 4.4.3. 

 [15] [START] 

When you click the [START] button, the program you selected under the column of 

“Program Mode” is executed. 
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 [16] [CLEAR] 

Used to clear an error status at the time 

of error generation. 

When you click the [CLEAR] button 

during error generation, the screen 

shown right is displayed. 

  (* The screen display will differ with 

the error contents.) 

  When you click [Yes], the error is 

cleared. 

 

 

 

 [17] [STOP] 

When you click the [STOP] button, the program stops only after the currently executed 

step has been executed. 

 

 [25] [SYNC. ORG SEARCH] 

When you click the [SYNC. ORG SEARCH] button, 

the [SYNC. ORG SEARCH] screen is displayed. 

When you click the [A0-A1 SEARCH EXECUTION],  

[A1-A2 SEARCH EXECUTION] or 

[A2-A3 SEARCH EXECUTION] button, 

the synchronized axis origin search of the indicated 

axes is executed. 

When you click the [CANCEL] button,  

the [SYNC. ORG SEARCH] screen is closed. 

 

 



4-31 

2. Execution screen of KCA-01-M05 

 * Only “COORDINATE(mm)” is checked firstly in the monitor column. 

 * Refer to 1. about the button which there is not a number for. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 [18] POINT TABLE No. set column 

The set point table is represented. Select the point table No. that you wish to operate. 

 [19] POINT TABLE EDIT 

When you click the [POINT TABLE EDIT] button, the point table editing screen (see Para. 

3.12) appears. When the screen closes, if some data are changed, all data are transmitted 

to the controller. 

 [20] SPEED/ACCEL TABLE EDIT 

When you click the [SPEED/ACCEL TABLE EDIT] button, the speed and 

acceleration/deceleration table editing screen (see Para. 3.7) appears. When the screen 

closes, if some data are changed, all data are transmitted to the controller. 

  

[18] [19] [20] [21] [22] [23] [24] 
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 [21] TORQUE LIMIT/AREA TABLE EDIT 

When you click the [TORQUE LIMIT/AREA TABLE EDIT] button, the torque limit and area 

table editing screen (see Para. 3.13) appears. When the screen closes, if some data are 

changed, all data are transmitted to the controller. 

 [22] PARAMETER 1 EDIT 

When you click the [PARAMETER 1 EDIT] button, the parameter 1 editing screen (see Para. 

3.9) appears. When the screen closes, if some data are changed, all data are transmitted to 

the controller. 

 [23] PARAMETER 2 EDIT 

When you click the [PARAMETER 2 EDIT] button, the parameter 1 editing screen (see Para. 

3.10) appears. When the screen closes, if some data are changed, all data are transmitted 

to the controller. 

 [24] Monitor column 

COORDINATE(mm), SPEED(mm/s), MOTOR ROTATION SPEED(rpm), CURRENT(A rms), 

DEVIATION COUNTER(PULSE), 

EFFECTIVE LOAD RATIO(%), DRIVING FORCE(N), INPUT(IN1-IN10), 

OUTPUT(OUT1-OUT8) are represented in real time. 

The items that are checked are renewed. The fewer the items that are checked are, the 

faster the renewal speed is. 

“0” represents the OFF state and “1” the ON state. The right end is bit 1. 
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■ 4.5.3 Monitor Function 

 It is possible to monitor the contents of the robot controller connected. 

When you click [Operation] – [Monitor] of the menu bar, or click the [ ] button on the tool bar, or 

click the [MONITOR] button on the program execution screen.  Then the monitor screen is 

displayed. 

 1. Monitor screen of Enhanced master unit, Master unit 

 * Initially, the step monitor status prevails on the display. 

 (1) Step monitor 

When you click the [STEP] button, the step monitor screen appears. 

The monitored items change automatically according to the program mode of the controller. 

While the controller is in the sequential mode, external point designation mode or pulse 

frequency mode, the [SEQUENTIAL STEP MONITOR] screen is displayed. 

When the controller is in the palletizing mode or easy mode, the [PALLETIZING RUN 

MONITOR] screen or [EASY RUN MONITOR] screen is displayed, respectively. 

  Sequential step monitor 

 

 

 

 

 

 

 

 

 

 

 

 

  

[1] [2] 

[3] 

[4] 
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  [1] [Task No.] 

You can change the task No. by using the 

[CHANGE] button. 

  [2] [SEQ–STEP] 

The step number of the controller 

connected and program code of this step 

are displayed real-time. 

  [3] SERVO 

The servo state is displayed.  

 

 [4] PROGRAM TRACE 

The each sequential program screen of the task which has steps is opened by clicking 

this button. 

 

 

 

 

 

 

 

 

The present step is highlighted with yellow. 

While robot stops, the present step is changed by clicking the number in No. column. 

Each screen is closed by clicking the [x] in the upper right of a screen. 
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  Palletizing run monitor 

 

 

 

 

 

 

 

 

  [1] [PROGRAM No.] 

The palletizing program number is displayed. 

  [2] [MODE] 

Either mode of "1 to M", "M to 1" or "M to M" is displayed. 

  [3] [OPERATION STATUS] 

The palletizing operation status is indicated by [START], [SOURCE], [DISTI.] or [END]. 

  [4] [P1], [P2], [P3] 

The current point is indicated by "Current quantities : Total quantities". 

  [5] [TAG No.] 

The tag number of the currently executed start program, hand program or end program 

is indicated. 

Unless either of the start program, hand program or end program is executed currently, 

"000" is displayed. 

  [6] [STEP No.] 

The sequential step number of the start program, hand program or end program is 

displayed. 

  

[1] [2] [3] 
[4] 

[6] [5] [7] [8] 
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  [7] [STEP No.] 

The sequential step number of the start program, hand program or end program is 

displayed.  

  [8] [STEP No.] 

The sequential step number of the start program, hand program or end program is 

displayed. 

 Ex. Point Designation monitor 

 

 

 

 

 

 

 

 

 

  [1] [TABLE No.] 

The point table number is displayed. 

When this is opened from execution screen, it is same as execution screen. When this 

is opened directly, the point table number designated by general inputs is displayed. 

  [2] [SERVO] 

The servo state is displayed. 

  [3] [DESIGNATED COORDINATE VALUE] 

The point value designated by the table number of [1] is displayed. 

  

[1] [3] [2] 
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  Easy run monitor 

 

 

 

  [1] [PROGRAM No.] 

The program number of the easy mode is displayed. 

  [2] [STEP No.] 

The program step number of the easy mode is displayed. 

  [3] [SEQUENTIAL STEP No.] 

The sequential step number currently executed is displayed during execution of the start 

subroutine program, hand subroutine program or end subroutine program. 

  [4] [TAG No.] 

The tag number of the currently executed start subroutine program, hand subroutine 

program or end subroutine program is indicated. 

Unless each subroutine program is executed currently, "000" is displayed. 

  [5] [LOOP] 

The number of repetitive counts of the predetermined operation is displayed.  (0 to 

9999) 

When zero (0) is specified, the operation is repeated endlessly. 

  

[1] [2] [3] 

[4] [5] 
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 (2) Input monitor 

 

 

 

 

 

  When you click the [INPUT] button, the “INPUT MONITOR” screen is displayed, where the 

condition of the current system input port and general-purpose input ports are displayed 

bit-by-bit. 

  “00000000” signifies the 8-bit data. The right end is bit 1, and the left end is bit 8. “0” 

represents the OFF state and “1” the ON state. 

The System input is displayed in [SYSTEM]. The meaning of each bit is written on the right 

hand.. 

When you click the display port changeover button provided on the left side of the screen, 

appropriate display port list is shown, where you can select a port you wish to display. 

The meaning of each abbreviation is as follows: 

   [SNo.] : Station number 

   [PN] : Port number 
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 (3) Output monitor 

 

  When you click the [OUTPUT] button, the “OUTPUT MONITOR” screen is displayed, where 

the condition of the current system output port and general-purpose output ports are 

displayed bit-by-bit. 

  “00000000” signifies the 8-bit data. The right end is bit 1, and the left end is bit 8. “0” 

represents the OFF state and “1” the ON state. 

The System output is displayed in [SYSTEM]. The meaning of each bit is written on the right 

hand. 

When you click the display port changeover button provided on the left side of the screen, 

appropriate display port list is shown, where you can select a port you wish to display. 

The meaning of each abbreviation is as follows: 

   [SNo.] : Station number 

   [PN] : Port number 
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 (4) Internal port monitor 

 

 

  When you click the [INTERNAL PORT] button, the “INTERNAL PORT MONITOR” screen is 

displayed, where the condition of the current internal ports are displayed bit-by-bit. 

  The meaning of the abbreviation is as follows: 

   [PN] : Port number 

 

 (5) Counter monitor 

 

 

 

 

  When you click the [COUNTER] button, the “COUNTER MONITOR” screen is displayed.  Up 

to twelve (12) counters can be monitored.  You can set each counter number you wish to 

monitor in the following manner. 

 

  Changeover of display counter: 

Click the [CNT**] button of the counter monitor 

you wish to set, and the “CNT No. CHANGE” 

screen appears on the display. 

When you enter the counter number you wish to 

monitor and click the [OK] button, the display 

counter number is replaced by the set value. 

When you click and check the “CONTINUOUS 

selection” check box on the “CNT No. CHANGE” 

screen beforehand, the counter numbers after the 

set counter number are set in turn automatically. 
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 (6) Timer monitor 

 

 

 

 

 

  When you click the [TIMER] button, the “TIMER MONITOR” screen is displayed, where the 

value of each timer is displayed real-time. 

 (7) Coordinate/offset monitor 

 

 

 

 

 

  When you click the [POINT/OFFSET] button, the “COORDINATE/OFFSET MONITOR” screen 

is displayed, where current coordinate and offset of each axis are in all tasks displayed. 
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 (8) I/O log 

 

 

 

 

 

 

 

 

 

  When you click the [I/O LOG] button, the “I/O LOG MONITOR” screen is displayed. 

I/O logs are added one by one from No.1 to No.99 every time I/O is changed. I/O logs are 

overwritten from No.1 after No.99. 

  ELAPSED TIME: Elapsed time from power on of the controller 

  MARGIN(s): Margin of the elapsed time with previous No. 

  I/O: IN in the case of input, OUT in the case of output 

  PORT: Input/output port (SYSTEM/JOG/In-1~4(Internal port)/0~3-01~08(General)) 

  VALUE: Value after changing 

  T1~4 STEP: Step No. at the time of changing (T1~4: Task 1~4) 

  Click the [START] button, and the indications of No.1 to No.99 are erased and the new log is 

added from No.1. 

  Click the [END] button, and the addition of the log is ended. 

  Click the [PREV] button, and the previous No. is displayed.  

  Click the [NEXT] button, and the next No. is displayed.  

  Click the [FILE OUTPUT] button, and the file designation screen is displayed. The I/O log of 

all No. can be saved with a CSV file. 

 

 (9) Cancel 

  When you click the [CANCEL] button, the monitor screen closes. 
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2. Monitor screen of KCA-01-M05 

 * Only “COORDINATE(mm)” is checked firstly in the monitor column. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  COORDINATE(mm), SPEED(mm/s), MOTOR ROTATION SPEED(rpm), CURRENT(A rms), 

DEVIATION COUNTER(PULSE),  

EFFECTIVE LOAD RATIO(%), DRIVING FORCE(N), INPUT(IN1-IN10), 

OUTPUT(OUT1-OUT8) are represented in real time. 

The items that are checked are renewed. The fewer the items that are checked are, the faster 

the renewal speed is. 

“0” represents the OFF state and “1” the ON state. The right end is bit 1. 

 

  Cancel 

When you click the [CANSEL] button, the monitor screen closes. 
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■ 4.5.4 Transmission to Controller 

 It is possible to send an edited program, table or parameter data to the controller. 

When you click [Operation] – [Send to Controller] of the menu bar, or click the [ ] button on the 

tool bar, the [TRANSMIT] screen is displayed. 

* Cannot transmit while robot is running. 

 

 Select the type of the file you wish to 

send from the dropdown list of “Text 

Data” and click the [OK] button.  Then 

the [Select file] screen is called on the 

display. 

 * Any comment in the data is not 

transmitted to the controller. 

 

  

 Select the file you wish to send and 

click the [OK] button. 
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 * When sending the sequential program, 

palletizing program, easy program, point table 

or MVM table, the “SPECIFY TRANSMIT 

RANGE” screen is displayed. 

Specify the range you wish to send, then click 

the [OK] button.  To stop transmission, click 

the [CANCEL] button. 

 

 

 The [TRANSMITTING] confirmation screen is displayed.  When you wish to send, click the [OK] 

button.  Otherwise, click the [Cancel] button. 

 When you click the [END] button during transmission, the transmission is interrupted (or canceled), 

and the data up to the interrupted point is sent to the controller. 

When transmission of group files currently under way is interrupted, an interrupted file is sent by up 

to the point of interruption, together with the preceding file or files, and a file or files after the 

interruption are not sent. 

 

 When the transmission has finished normally, a 

message saying that the transmission has finished is 

displayed.  Click the [OK] button then. 

 

 After Robot type or Parameter 2 or Parameter 3 has been sent, the controller power has to be 

turned off once.  After the controller power is turned on again, the parameter transmitted is valid. 

 *When the setting of the controller is KCA-01-M05, if the value of Robot type or Parameter 2 is not 

changed, the controller power doesn’t have to be turned off once. 

 To terminate the [TRANSMIT] screen, click the [END] button. 
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■ 4.5.5 Receiving from Controller 

 It is possible to receive a program, table or parameter data from the controller. 

When you click [Operation] – [Receive from Controller] of the menu bar, or click the [ ] button on 

the tool bar, the “RECEIVE” screen is displayed. 

 

 Select the type of the file you wish to 

receive from the dropdown list of “Text 

Data” and click the [OK] button.  Then 

the [Select file] screen is called on the 

display. 

 * When you have checked the 

[ADDITION OF COMMENT] check 

box beforehand, a comment 

included in the received file is 

recalled. 

When you have canceled the check 

of the check box, a comment in the 

received file is deleted. 

 

  

 When you wish to receive the data in a 

new file, input the file name and click 

the [Save] button.  When you wish to 

receive the data in the existing file, 

select the file and click the [Save] 

button.  
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 * When receiving the sequential program, 

palletizing program, easy program, point table 

or MVM table, the “SPECIFY RECEIVED 

RANGE” screen is displayed. 

Specify the range you wish to receive, then 

click the [OK] button.  To stop receiving, click 

the [CANCEL] button. 

 

  

 The [RECEIVING] confirmation screen is displayed.  

When you wish to receive, click the [OK] button.  

Otherwise, click the [Cancel] button. 

  

 

 *The sequential program can be received during operation. (Also it is in group file) 

Only after the data has reached normally, it is written to the specified file. 

If the communication has been severed while the data was received in the SAVE mode (i.e., 

overwriting of the exiting file), the previous file remains. 

If the communication has been disconnected while the data was received in the SAVE AS mode 

(writing of the new file), the new file is not created and the operation finishes. 

If the communication has been interrupted while group files were received, a file or files after the 

interrupted file are not received.  A file or files before the interruption are already received. 

 

 

  

 When the receiving has finished normally, a message 

saying that the receiving has finished is displayed.  

Click the [OK] button then. 

 To terminate the [RECEIVE] screen, click the [END] 

button.  
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■ 4.5.6 Online edit 

 It is possible to do online edit a program, table or parameter data. 

When you click [Operation] – [Online edit] of the menu bar, or click the [    ] button on the tool bar, 

the “ONLINE EDIT” screen is displayed.  

* Cannot do online edit while robot is running. 

 

 Select the type of the file you wish to do 

online edit from the dropdown list of 

“File Type”. 

 * Any comment cannot be used. 

 

  

 * When receiving the sequential program, 

palletizing program, easy program, point table or 

MVM table, the “SPECIFY RECEIVED RANGE” 

screen is displayed. 

Specify the range you wish to do online edit, then 

click the [OK] button.  To stop doing online edit, 

click the [CANCEL] button. 
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 The edit screen of the specified 

file type is opened. 

  

 Click [x] in upper right of the 

screen after editing. 

 

 

 When the contents are changed,  

transmission confirmation screen is displayed.  

If you wish to transmit, click the [OK] button.  

If not, click the [CANCEL] button. 

 

 When you click the [END] button during transmission, the transmission is interrupted (or canceled), 

and the data up to the interrupted point is sent to the controller. 

 

 When the transmission has finished normally, a 

message saying that the transmission has finished is 

displayed.  Click the [OK] button then. 

 

 After Robot type or Parameter 2 or Parameter 3 has been sent, the controller power has to be 

turned off once.  After the controller power is turned on again, the parameter transmitted is valid. 

 *When the setting of the controller is KCA-01-M05, if the value of Robot type or Parameter 2 is not 

changed, the controller power doesn’t have to be turned off once. 

 To terminate the [ONLINE EDIT] screen, click the [END] button. 
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■ 4.6 Option 

 

■ 4.6.1 Register Group 

 

 It is possible to register and edit group files 

by opening the [GROUP FILE EDIT] 

screen. 

 When you click [Option] – [Register Group] 

of the menu bar, or click the [ ] button on 

the tool bar, the screen for specifying the 

group file [Select file] appears. 

 

 

 When you wish to create a new group file, enter the file name and click the [Save] button.  To edit 

the existing group file, select it and click the [Save] button.  Then the “GROUP FILE EDIT” screen 

is called on the display. 

 * When any editing screens are not opened, 

the screen as shown right is displayed. 

Select the used controller and click the [OK] button. 

 

 • [GROUP FILE EDIT] screen 

 

 [1] [Printing Title] 

When you enter characters as the printing title under this column, they are printed on all 

pages. 

 [2] Each file ON/OFF 

Select ON or OFF of each file by means of the option button. 

A file which is made valid is included in the group, and a file which is made invalid is excluded 

from it. 

 [3] File name 

A program and table in the same holder containing the group files can be added to the group 

as the group files. 

The default of the file name is the same as the group file name, which can be changed, 

however.  

KCA-SF-98D 
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 [4] Range setting 

The edit range can be selected for each file.  Thus, unnecessary step or steps are not 

transmitted or not printed. 

For the new group file, a default value is displayed under the column of the setting range.  

Specify the value within this range. 

 [5] Register Group 

When you click the [OK] button, relevant file or files are registered as the group file. 

 [6] [CANCEL] 

When you click the [CANCEL] button, the contents of the [GROUP FILE EDIT] screen are not 

saved, and the same screen closes. 

[1] [2] [3] [4] 

[5] [6] 
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■ 4.6.2 Setting of System Environment 

 It is possible to set a text file holder, received file holder, type of the controller to be connected and 

communication conditions. 

When you click [Option] – [System Environment], the “SYSTEM ENVIRONMENT SETTING” screen 

opens. 

 • [SYSTEM ENVIRONMENT SETTING] screen 

 

 

  

 

 

 

 

 

 

 

 

 [1] [DIRECTORY SETTING] column 

Specify the folders under the column of “TEXT FILE” and “RECEIVED”. 

When you wish to change the folder, click the [REFER…] button to open the [SETTING OF 

DIRECTORY NAME] screen.  Select another folder and click the [OK] button.  To stop the 

change, click the [CANCEL] button. 

When [RECEIVED FILE IS EQUALIZED TO TEXT FILE] is checked, received file is 

equalized to text file and the folder of received file cannot be changed  

 [2] [CONTROLLER TYPE] column 

Select the type of the controller connected to the personal computer from the dropdown list, 

then click it. 

When you click the [SETTING] button, the “COMMUNICATION CONDITION” screen opens. 

 [3] [ALL-CLEAR SEQUENTIAL BEFORE TRANSMIT] column 

When you select “DELETE”, all sequential programs in the controller are cleared before 

transmission.  When you select “NOT DELETE”, only the range of the sequential file to be 

transmitted is overwritten. 

[1] 

[2] [3] [4] [5] 
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 [4] [OK] button 

When you wish to set the change you have done on the “SYSTEM ENVIRONMENT 

SETTING” screen, click the [OK] button.  Then the new system environment is set with the 

“SYSTEM ENVIRONMENT SETTING” screen closed. 

 [5] [CANCEL] button 

When you do not wish to set the change you have done on the “SYSTEM ENVIRONMENT 

SETTING” screen, click the [CANCEL] button.  Then the existing system environment 

remains unchanged with the “SYSTEM ENVIRONMENT SETTING” screen closed. 

 • [COMMUNICATION CONDITION] screen 

 

 

 

 

 

 

 

 [1] [DATA LENGTH]: 8 

 [2] [STOP BIT]: 1 

 [3] [PARITY]: EVEN (E) 

 [4] [FLOW CONTROL]: NONE 

  DO NOT change the setting of the above four (4) items. 

[1] 

[2] 

[3] 

[4] 

[5] 

[6] 

[7] 

[8] 
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 [5] [PORT] 

Select the communication port you wish to use from the dropdown list. 

For the communication port, see the instruction manual of the personal computer you are 

using now, and the Windows instruction manual. 

 [6] [BAUD RATE] 

Select the baud rate from drop down list. This setting is valid for the controller from KBB 

series forth. In case of the controller this setting is invalid for, any setting is regarded as 

[9600]. 

 [7] [OK] button 

When you wish to set the change you have done on the “COMMUNICATION CONDITION” 

screen, click the [OK] button.  Then the new communication conditions are set with the 

“COMMUNICATION CONDITION” screen closed. 

 [8] [CANCEL] button 

When you do not wish to set the change you have done on the “COMMUNICATION 

CONDITION” screen, click the [CANCEL] button.  Then the existing communication 

conditions remain unchanged with the “COMMUNICATION CONDITION” screen closed. 
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■ 4.6.3 Setting of Robot Type 

 Once you have specified the robot type, you can set various parameters to the values optimized for 

the axis (or actuator) to be used. 

When you click [Option] – [Set Robot Type], the “ROBOT TYPE SETTING” screen appears on the 

display. 

 * Before executing this operation, connect the personal computer with the robot controller and 

make the controller ready for the operation. 

For the key parameters relating to the robot motions, when you have specified the robot type, 

the optimal values for the axis (or actuator) to be used are input. 

For the robot type (i.e., six (6)-digit number), see the actuator instruction manual provided 

separately. 

Once you have set the robot type, the parameter values return to the default values.  When 

you use the robot after changing the parameter values, take careful precautions. 

 * [ROBOT TYPE SETTING] screen 

 

  [Station No.] 

When you specify the station number you wish to set 

under the column of “Station No.”, the robot type 

currently set is shown under “ROBOT TYPE”. 

  [ROBOT TYPE] 

When you wish to change the robot type, enter a six 

(6)-digit number under “ROBOT TYPE” and click the 

[SET] button.  If you have entered an illegal robot type, 

the previous robot type is shown again. 

 

 

  

  [END] button 

After you have set the robot type, click the [END] 

button.  Then the message urging you to turn off the 

controller power once, and on again is displayed. 
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  Unless you have turned off the controller power once, then on again after entering the robot type, 

the controller will not run.  When this happens, turn off the controller power once, then on again 

according to the comment displayed, then click the [OK] button. 

*When the setting of the controller is KCA-01-M05, if the value of Robot type is not changed, the 

controller power doesn’t have to be turned off once. 

 

■ 4.6.4 Confirmation of Controller Version 

 

 It is possible to display the controller ROM version. 

 * Before executing this operation, connect the 

personal computer with the robot controller and 

make the controller ready for the operation. 

 When you click [Option] – [Controller Version], the 

“Controller Version” screen is called, where the version 

of the master unit and slave units (axis 1 to axis 4) are 

displayed. 

To close the same screen, click the [OK] button. 
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■ 4.6.5 File Convert 

 This function can convert the data that are edited and saved with old personal computer software 

KCA-SF-98C into the data that can be edited with this personal computer software KCA-SF-98D or 

the data of KBA, KBB series controller into the data of KBX series controller. 

The data that can be converted are sequential program and point table in the former, all data that 

are common to before and after converting in the latter. 

When you click [Option] – [File Convert], the “FILE CONVERT” screen appears 

 

 

 

 

 

 

 

 

 

 

 

 

 

 [1] [TYPE (SOURCE)] 

Select the type (source) from the drop down list. 

 [2] [TYPE (DESTINATION)] 

Select the type (destination) from the drop down list. The selectable types (destination) are 

different by the type (source) as the following. 

 

 

 

 

 

 

 

[1] 

[3] 

[2] 

[5] [4] [6] 

[7] 

[8] 
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 [3] [SELECT FILE] button 

”Selection of a file” screen appears, then select a file type and click [OK] button. 

File selection dialogue appears, then select the file you want to convert. 

* When the setting of [1], [2] is changed after selection the file, the file 

  selection is invalid. So select the file again.  

* When “GROUP” is selected, the files whose setting is valid in the “GROUP” 

  are also converted. 

 

 

 

 

 

 

 

 [4] OPTION 

This is unused. 

 [5] [CONVERT] button 

After selecting a file at [3], convert the selected file by clicking the [CONVERT] button. 

The converted file is made in the same folder as the file of type (source). And the file’s name 

is the same as the file of type (source) (not same only extension). 

* In case of option column is checked, the two file of sequential file and point file are made at 

the same time. 

* In case of the file whose name is the same as the converted file’s name has already 

existed, the overwriting confirmation screen appears. 

* “File(source)” is not deleted.  

* When a file of parameter 1 is converted, the message below is displayed. 

Click the [OK] button, after confirmation. 
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* When a file of robot type is converted, the screen below is displayed. Select how to covert 

robot type from A0 to A3 and click the [OK] button. In case of [CANCEL] button is clicked, 

robot type is not converted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Case of selection “CONVERT INTO EQUIVALENT MODEL OF KBX SERIES” 

Select it in case of exchanging for the same model in KBX. In addition, select “AXIS 

TYPE” of the model. (There are instances where several proposed robot type exist 

because a robot type correspond several models in KBB.) 

When “AXIS TYPE” is changed, the message below is displayed. 

Click the [OK] button, after confirmation. 

 

 

 

 

 

* In case of no same model in KBX series, it cannot be selected. 

 

2. Case of selection “CONVERT INTO DEFAULT OF KBX SERIES” 

Select it in case of no same model in KBX series or in case of exchanging for the 
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different model in KBX. Input robot type before operating robot. 

 

3. Case of selection “DO NOT CONVERT” 

Select it in case of not exchanging in KBX series. 

 

 

 [6] [END] button 

The “FILE CONVERT” screen closes and end “File Convert” by clicking the [END] button. 

 

 [7] [FILE (SOURCE)] button 

After selecting a file in [3], the path of the selected file is displayed. 

 

 [8] [FILE (DESTINATION)] button 

After selecting a file in [3], the path of the made file when the selected file is converted is 

displayed. 
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■ 4.6.6 Program Compare 

 It is possible to compare the data in the robot controller with the file saved in the personal computer 

and to display the difference, if any. 

 * Before executing this operation, connect the personal computer with the robot controller and 

make the controller ready for the operation. 

In the [Program Compare] mode, the data in the controller is once sent to the personal 

computer and compared there. 

 

 When you click [Option] – [Program 

Compare], the “PROGRAM COMPARE” 

screen appears on the display. 

 Select the type of the file from the 

dropdown list of “TEXT DATA” and click the 

[OK] button.  Then the [COMPARE FILE] 

screen is displayed. 

 

  

 Specify the file you wish to compare, and 

click the [Open] button. 

 

  

KCA-SF-98D 
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 * When you wish to compare the 

sequential program, palletizing 

program, easy program, point table or 

MVM table, the “SPECIFY RECEIVED 

RANGE” screen appears. 

Specify the range for program 

comparison and click the [OK] button.  

To stop the program comparison, click 

the [CANCEL] button. 

 

  

 When the confirmation screen is displayed, 

click the [OK] button if you wish to receive 

the data from the controller.  If you do not 

wish, click the [Cancel] button. 

*The sequential program can be received 

during operation. 

 If you click the [END] button during 

receiving of the data, it is interrupted (or 

canceled). 

 

 

 

   

 When the data has reached normally, the 

[COMPARE RESULT] screen is displayed. 

  

 If the difference has been 

found in the program, the 

details are displayed. 

 To exit from the 

“PROGRAM COMPARE” 

screen, click the [END] 

button. 
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■ 4.6.7 Error History 

  

Represent error history of the controller.  

When the setting of the controller is KCA-20-M10/M40, KCA-10-M10/M40, this function is invalid. 

* Before executing this operation, connect the personal computer with the robot controller and 

make the controller ready for the operation. 

 

When you click [Option] – [Error History], the “ERROR HISTORY” screen appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you click [RENEWAL], the error history is renewed. 

When you click [END], the “ERROR HISTORY” screen is closed and end the error history. 

When you click [PREV], the error history of the previous 20 items is represented. 

When you click [NEXT], the error history of the next 20 items is represented.  

When you click [FILE OUTPUT], the file designation screen is displayed. The error history of all 

No. can be saved with a CSV file. 

 

*When the setting of the controller is KCA-25-M10/M40, “ALARM CODE” is not represented. 

*When the setting of the controller is KCA-01-M05, “ALARM CODE” and “ELAPSED TIME” are 

not represented. 
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■ 4.6.8 Memory Initialization 

  

Initialize the memory of the controller. The items that can be selected depend on the setting of the 

controller. 

* Before executing this operation, connect the personal computer with the robot controller and 

make the controller ready for the operation. 

 

When you click [Option] – [Memory Initialization], the “MEMORY INITIALIZATION” screen 

appears. 

 

Select an item you want to initialize,  

and click [OK] button. 

When you cancel it, click [CANCEL] button. 

 

 

 

 

 

The confirmation screen appears. 

When you initialize it, click [OK] button. 

When you cancel it, click [CANCEL] button. 

 

 

 

The result screen appears. 

The controller power has to be turned off once in case of “MEMORY ALL CLEAR”. 

The controller power does not have to be turned off once in case of the other. 
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■ 4.7 Window 

 

■ 4.7.1 Cascade 

 When a plural number of windows are opened at the same time on the editing screen, click 

[Window] – [Cascade], and the windows are displayed in cascade. 

 

 

■ 4.7.2 Horizontal Tile 

 When a plural number of files are opened at the same time on the editing screen, click [Window] – 

[Horizontal Tile], and the windows are displayed in horizontal tile. 
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■ 4.7.3 Vertical Tile 

 When a plural number of files are opened at the same time on the editing screen, click [Window] – 

[Vertical Tile], and the windows are displayed in vertical tile. 

 

 

 

 

 

 

 

 

 

 

 

 

■ 4.8 Help 

 

■ 4.8.1 About KCA-SF-98D 

When you click [Help (H)] – [About KCA-SF-98D], the version information of this tool is displayed. 
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This page is blank. 

 

 



5-1 

Chapter 5 Others 

 

■ 5.1 Error 

 The errors displayed by the KCA–SF–98D are as follows: 

 

• [Code] : 3 

[Display] : Could not send to the controller. 

[Timing of error generation] : File transmission 

[Meaning/Cause] : Communication line error, or stop of transmission. 

[Remedy] : Check for the communication line and controller power. 

• [Code] : 4.0 

[Display] : Communication error. Stop the robot. Check for the 

communication line and controller power. Before resuming the 

program, close the execution screen once. 

[Timing of error generation] : Execution screen 

[Meaning/Cause] : Communication line error. 

[Remedy] : Check for the communication line and controller power. 

Before restarting the program, close the execution screen once. 

• [Code] : 4.1 

[Display] : Communication error. Could not execute the monitor. Check for the 

communication line and controller power. Before resuming the 

monitor, close the monitor screen once. 

[Timing of error generation] : Monitor screen 

[Meaning/Cause] : Communication line error. 

[Remedy] : Check for the communication line and controller power. 

Before restarting the monitor, close the monitor screen once. 
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• [Code] : 4.3 

[Display] : Communication error. File transmission stops. Check for the 

communication line and controller power. Before resuming file 

transmission, close the transmit screen once. 

[Timing of error generation] : File transmission 

[Meaning/Cause] : Communication line error. 

[Remedy] : Check for the communication line and controller power. 

Before restarting the transmission, close the transmit screen once. 

• [Code] : 4.4 

[Display] : Communication error. File receiving stops. Check for the 

communication line and controller power. Before resuming file 

receiving, close the receive screen once. 

[Timing of error generation] : File receiving 

[Meaning/Cause] : Communication line error. 

[Remedy] : Check for the communication line and controller power. 

Before restarting the receiving, close the receive screen once. 

• [Code] : 4.8 

[Display] : Communication error. Stop the setting of robot type. Check for the 

communication line and controller power. Before resuming the 

setting of robot type, close the robot type setting screen once. 

[Timing of error generation] : Setting of robot type 

[Meaning/Cause] : Communication line error. 

[Remedy] : Check for the communication line and controller power. 

Before restarting the setting of robot type, close the robot type setting 

screen once. 
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• [Code] : 4.9 

[Display] : Communication error. Stop the robot. Check for the 

communication line and controller power. Before resuming the 

teaching, close the teaching screen once. 

[Timing of error generation] : Teaching 

[Meaning/Cause] : Communication line error. 

[Remedy] : Check for the communication line and controller power. 

Before restarting the teaching, close the teaching screen once. 

• [Code] : 5 

[Display] : No transmit data is found. File (File Name   ) transmission stops. 

[Timing of error generation] : File transmission 

[Meaning/Cause] : No data to be transmitted is available. 

[Remedy] : Check for the file on the editing screen. 

• [Code] : 9 

[Display] : File could not be loaded. 

[Timing of error generation] : File transmission and receiving. 

[Meaning/Cause] : Access to the file is not possible. 

[Remedy] : Check for the file contents on the editing screen. 

• [Code] : 10 

[Display] : No text file exists in the group file. 

[Timing of error generation] : File transmission and receiving. 

[Meaning/Cause] : No file exists in the group file. 

[Remedy] : Check for the setting of the group file.  (See Para. 4.6.1.) 

• [Code] : 12 

[Display] : Communication line could not open. Check for the setting of 

communication conditions. 

[Timing of error generation] : At the start of communication. 

[Meaning/Cause] : The communication port is not correct. 

[Remedy] : Check for the setting of the communication conditions.  (See Para. 

4.6.2.) 
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• [Code] : 14 

[Display] : Receiving stops. 

[Timing of error generation] : File receiving 

[Meaning/Cause] : Communication error 

[Remedy] : Check the communication cable and connector for connections. 

• [Code] : 16 

[Display] : Could not save file. RUN-TIME ERROR CODE: 

[Timing of error generation] : File receiving 

[Meaning/Cause] : Saving of received data was not possible. 

[Remedy] : Terminate the KCA–SF–98D once, then restart and try again. 

• [Code] : 17 

[Display] : Controller setting is illegal. 

[Timing of error generation] : At the start of communication. 

[Meaning/Cause] : The type of the controller is not identical. 

[Remedy] : Check the controller for the setting.  (See Para. 4.6.2.) 

• [Code] : 20 

[Display] : Cannot execute. (Parameter 2 was changed. Turn off the controller 

power once, then on again.) 

[Timing of error generation] : At the start of the execution screen. 

[Meaning/Cause] : The Parameter 2 was changed partially. 

[Remedy] : Turn off the controller power once, then on again. 

• [Code] : 21 

[Display] : Cannot send file. 

[Timing of error generation] : File transmission 

[Meaning/Cause] : The controller was in operation. 

An error was found in the controller. 

[Remedy] : Stop the controller, then try again. 
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• [Code] : 22 

[Display] : While program is running, SEQUENTIAL PROGRAM receiving is 

impossible.. 

[Timing of error generation] : Sequential program receiving 

[Meaning/Cause] : The controller was in operation. 

[Remedy] : Stop the controller, then try again. 

• [Code] : 23 

[Display] : Cannot set the robot type. 

[Timing of error generation] : Setting of robot type 

[Meaning/Cause] : The controller was in operation. 

[Remedy] : Stop the controller, then try again. 

• [Code] : 24 

[Display] : Cannot teach. (Parameter 2 was changed. Turn off the controller 

power once, then on again.) 

[Timing of error generation] : Teaching 

[Meaning/Cause] : The Parameter 2 was changed partially. 

[Remedy] : The parameter 2 was changed partially.  Turn off the controller power 

once, then on again. 

• [Code] : 25 

[Display] : Cannot teach. 

[Timing of error generation] : Teaching 

[Meaning/Cause] : The controller was in operation. 

[Remedy] : Stop the controller, then try again. 

• [Code] : 31 

[Display] : Servo is not locked. Lock the servo. 

[Timing of error generation] : Teaching or jog or execution screen 

[Meaning/Cause] : Home return of the robot was commanded while the servo was 

set free. 

While the servo was set free, change to remote teaching mode 

was commanded. 

[Remedy] : Lock the servo. 
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• [Code] : 32 

[Display] : Home return was not done. Execute home return. 

[Timing of error generation] : Teaching 

[Meaning/Cause] : While the robot was yet to return to the home point, you have 

written the jog data or clicked the [RUN] button. 

[Remedy] : Return the robot to the home point first. 

• [Code] : 33 

[Display] : Program is running and you cannot terminate. 

[Timing of error generation] : Execution screen 

[Meaning/Cause] : While the program was running, you were about to close the 

execution screen. 

[Remedy] : After the program execution has finished, close the screen. 

• [Code] : 34 

[Display] : Servo is locked. Set the servo free. 

[Timing of error generation] : Teaching 

[Meaning/Cause] : The direct teaching mode has been selected while the servo 

was locked. 

[Remedy] : Set the servo in the free state. 

• [Code] : 35 

[Display] : Could not lock the servo. 

[Timing of error generation] : Servo lock screen 

[Meaning/Cause] : The servo lock is not possible. 

[Remedy] : Quit the robot execution screen once, then call the execution screen 

again.  Then the error code is displayed.  Remedy according to the 

error code table (See Para. 5.2) and descriptions on error messages as 

carried in the controller instruction manual. 
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• [Code] : 36 

[Display] : Monitoring now. Cannot stop. Stop by closing the monitor screen? 

[Timing of error generation] : Execution screen 

[Meaning/Cause] : The [STOP] button has been clicked during monitoring. 

[Remedy] : Click the [OK] button, and you can close the monitor screen and stop 

the program. 

• [Code] : 40 

[Display] : Controller mode is wrong. Cannot send group file. 

[Timing of error generation] : Group file transmission 

[Meaning/Cause] : The controller is in a mode other than the SEQUENTIAL and 

PALLETIZING modes. 

[Remedy] : Select the SEQUENTIAL mode.  (See Para. 4.5.2.) 

• [Code] : 41 

[Display] : Controller mode is wrong. Cannot send sequential program. 

[Timing of error generation] : File transmission 

[Meaning/Cause] : The controller is in a mode other than the SEQUENTIAL and 

PALLETIZING modes. 

[Remedy] : Select the SEQUENTIAL mode.  (See Para. 4.5.2.) 

• [Code] : 42 

[Display] : Controller mode is wrong. Cannot send palletizing program. 

[Timing of error generation] : File transmission 

[Meaning/Cause] : The controller is in a mode other than the SEQUENTIAL and 

PALLETIZING modes. 

[Remedy] : Select the SEQUENTIAL mode.  (See Para. 4.5.2.) 
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• [Code] : 43 

[Display] : Robot type No. error 

[Timing of error generation] : Setting of robot type 

[Meaning/Cause] : Robot type setting error. 

[Remedy] : See the descriptions on the robot type as described in the actuator 

instruction manual. 

• [Code] : 51-60, 63-67 

[Display] : A parameter which is neglected due to different controller version 

exists. 

Parameter name: ***** 

[Timing of error generation] : File transmission 

[Meaning/Cause] : The parameter which is neglected is transmitted to the 

controller. 

[Remedy] : Upgrade the controller version. 

• [Display] : Error occurred in the controller. Cancel [ErrCode] error? 

[Timing of error generation] : At the start of communication. 

[Meaning/Cause] : Communication was about to start while an error was found in 

the controller. 

[Remedy] : Cancel the error.  Unless it can be canceled, remedy according to the 

error code table (See Para. 5.2) and descriptions on error messages as 

carried in the controller instruction manual. 

• [Display] : Illegal text is found in the file. 

[Timing of error generation] : At the time of file reading. 

[Meaning/Cause] : Reading of some data in the data area is not possible.  (File 

created by using other software.) 

[Remedy] : Check for the contents of the relevant file by using other software such 

as editor. 

• [Display] : Cannot open any further due to memory or resource shortage. 

[Timing of error generation] : At the time of file reading. 

[Meaning/Cause] : Access error at file loading. 

[Remedy] : Close the other screen. 

  



5-9 

• [Display] : Path name is illegal. 

[Timing of error generation] : At the time of file reading and saving. 

[Meaning/Cause] : The path name was specified illegally. 

[Remedy] : Enter the legal path name. 

• [Display] : Cannot read the drive. Try again? 

[Timing of error generation] : At the time of file reading and saving. 

[Meaning/Cause] : No floppy disk is inserted. 

[Remedy] : Make sure that the floppy disk is set correctly. 

• [Display] : Cannot edit any more. 

[Timing of error generation] : At the time of file reading. 

[Meaning/Cause] : The number of program editing screens exceeds the 

predetermined value. 

[Remedy] : Close the other window or windows. 

• [Display] : The file is already open. 

[Timing of error generation] : At the time of file reading. 

[Meaning/Cause] : You are about to read the file bearing the same name. 

[Remedy] : The file already opened cannot be opened again. 

• [Display] : Illegal value. 

[Timing of error generation] : At the time of data editing. 

[Meaning/Cause] : The number of digits below the decimal point is not identical. 

[Remedy] : Enter the legal value. 

• [Display] : Illegal file name ****. 

[Timing of error generation] : At the time of group setting. 

[Meaning/Cause] : The specified file name is illegal. 

[Remedy] : Enter the legal file name. 

• [Display] : Illegal input range of ****. 

[Timing of error generation] : At the time of group setting. 

[Meaning/Cause] : The specified range is illegal. 

[Remedy] : Enter the legal range. 
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• [Display] : Line ** of program ** is already input. Cannot input any more. 

[Timing of error generation] : At the time of line insertion. 

[Meaning/Cause] : The data has been input to the final line of the setting range. 

[Remedy] : Increase the range, or delete any unnecessary step or steps. 

• [Display] : Line ** of program ** is already input. Cannot input any more. 

[Timing of error generation] : At the time of paste during editing of sequential 

program. 

[Meaning/Cause] : The data has been input to the final line of the setting range. 

[Remedy] : Increase the range, or delete any unnecessary step or steps. 

• [Display] : Specified step No. cannot be found. 

[Timing of error generation] : At the time of step number search. 

[Meaning/Cause] : The specified step number cannot be found. 

[Remedy] : Check for the setting range. 

• [Display] : Exceeds the range of the program opened now. 

[Timing of error generation] : At the time of step number search (easy program). 

[Meaning/Cause] : The specified program number is illegal. 

[Remedy] : Check for the setting range. 

• [Display] : File to be printed is not specified. 

[Timing of error generation] : At the time of printing. 

[Meaning/Cause] : No file is specified. 

[Remedy] : Specify the file. 

• [Display] : One or more visual basic applications are running. Please close 

those applications, then choose OK to continue. 

[Timing of error generation] : At the time of installing. 

[Meaning/Cause] : The install program will not run because other program 

created by using the Visual Basic of Microsoft is running now. 

[Remedy] : Terminate the relevant program, then install again.  You have to restart 

the Windows after terminating the relevant program under some 

occasions. 
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■ 5.2 Error Code Table 

 This paragraph describes the error messages and error codes. 

For details on each error, see ”Err Messages” of the controller instruction manual provided separately. 

 

1.Enhanced master unit, Mater unit 

Code Description Code Description 

12 WDT (watchdog timer) error 3D Axis 2 Encoder changeover error 

13 Emergency stop 3F Axis 2 Driver error 

20 Axis 1 Communication error 40 Axis 3 Communication error 

21 Axis 1 Overspeed error 41 Axis 3 Overspeed error 

22 Axis 1 Overcurrent error 42 Axis 3 Overcurrent error 

23 Axis 1 Overload error 43 Axis 3 Overload error 

24 Axis 1 Overflow 44 Axis 3 Overflow 

26 Axis 1 Encoder error 46 Axis 3 Encoder error 

28 Axis 1 Soft limit over (at execution) 48 Axis 3 Soft limit over (at execution) 

29 Axis 1 Soft limit over (at execution) 49 Axis 3 Soft limit over (at execution) 

2A Axis 1 Overvoltage error 4A Axis 3 Overvoltage error 

2B Axis 1 Motor overheat error 4B Axis 3 Motor overheat error 

2C Axis 1 Encoder backup error 4C Axis 3 Encoder backup error 

2D Axis 1 Encoder changeover error 4D Axis 3 Encoder changeover error 

2F Axis 1 Driver error 4F Axis 3 Driver error 

30 Axis 2 Communication error 50 Axis 4 Communication error 

31 Axis 2 Overspeed error 51 Axis 4 Overspeed error 

32 Axis 2 Overcurrent error 52 Axis 4 Overcurrent error 

33 Axis 2 Overload error 53 Axis 4 Overload error 

34 Axis 2 Overflow 54 Axis 4 Overflow 

36 Axis 2 Encoder error 56 Axis 4 Encoder error 

38 Axis 2 Soft limit over (at execution) 58 Axis 4 Soft limit over (at execution) 

39 Axis 2 Soft limit over (at execution) 59 Axis 4 Soft limit over (at execution) 

3A Axis 2 Overvoltage error 5A Axis 4 Overvoltage error 

3B Axis 2 Motor overheat error 5B Axis 4 Motor overheat error 

3C Axis 2 Encoder backup error 5C Axis 4 Encoder backup error 
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Code Description Code Description 

5D Axis 4 Encoder changeover error B5 Port No. error 

5F Axis 4 Driver error B6 Table No. error 

60 Cannot execute continuously. B7 Group No. error 

61 Home return is yet to complete. B8 Robot No. error 

62 Cannot execute. B9 Easy program No. error 

63 Task cannot be started. BA Task No. error 

90 ID error C0 Axis 1 Soft limit over plus "+" 

91 Sequential program memory error C1 Axis 1 Soft limit over minus "–" 

92 Palletizing program memory error C2 Axis 2 Soft limit over plus "+" 

93 Parameter memory error C3 Axis 2 Soft limit over minus "–" 

94 Point table memory error C4 Axis 3 Soft limit over plus "+" 

95 Speed table memory error C5 Axis 3 Soft limit over minus "–" 

96 Acceleration/deceleration table memory 

error 

C6 Axis 4 Soft limit over plus "+" 

97 MVM table memory error C7 Axis 4 Soft limit over minus "–" 

98 Easy program memory error E0 Other error 

99 Slave ID error   

A0 Command error (Impossible error)   

A1 No tag designation   

A2 Tag duplicated definition   

A3 Stack over flow   

A4 Stack under flow   

A8 Parameter error   

B0 Step No. error   

B1 Tag No. error   

B2 Palletizing program No. error   

B3 Counter No. error   

B4 Timer No. error   
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2. KCA-01-M05 

Code Description 

11 Over current 

21 Over load 

31 Over speed 

41 Position counter overflow 

42 Positional deviation exceeded 

51 Over heat 

61 Sensor error(Disconnection while power 

is on) 

62 Sensor error(Disconnection during 

backup) 

63 Sensor error(1-rotation count) 

64 Sensor error(Mixing) 

65 Sensor error(Overflow) 

66 Battery error 

67 Backup error 

71 Over voltage 

72 Voltage down 

81 Emergency stop 

91 Nonvolatile memory read error 

92 Nonvolatile memory write error 

98 CPU error 

99 Parameter error 

101 Execution Impossible 

102 Return To Origin Not Completed 

103 + Soft limit over 

104 - Soft limit over 

105 Writing Impossible 
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■ 5.3 Check Items When Communication Is Not Possible 

 If the communication with the controller is not possible, perform check on the following items. 

 • Make sure that the communication setting is done correctly. 

For details, see Para. 4.6.2 above. 

 • RS232C cable connection 

Make sure that the cable is connected properly as shown below, without being broken. 

Personal computer cable pin assignment table 

 

Signal name Pin No. Pin No. Signal name

RXD 2 2 GND

TXD 3

DTR 4 5 TXD

GND 5 6 RXD

DSR 6

RTS 7 8 GND

CTS 8 FG (ground plate)

FG Hood case FG

PC side

PCBL-31
Controller side

D-SUB 9-pin (female) Half pitch 14-pin

 

 

 

 

Socket: XM2D–0911 

       (OMRON-make, or equivalent) 

Hood: XM2S–0911 

       (OMRON-make, or equivalent) 

 Plug: 10114–3000VE (3M-make) 

Shell: 10314–52F0–008 (3M-make) 
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